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Preface

This guide describes how to install, configure, and use VERITAS NetBackup for DB2 
agent on a UNIX platform. 

For specific information about the NetBackup server software, refer to: 

◆	 NetBackup System Administrator’s Guide for UNIX, Volumes I and II, if you have a UNIX 
server. 

or 

◆	 NetBackup System Administrator’s Guide for Windows, Volumes I and II if you have a 
Windows server. 

This document is the same as NetBackup_AdminGuide_DB2_UNIX.pdf distributed 
with the NetBackup for DB2 on UNIX software. 
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Audience 
Audience 
This guide is intended for the: 

◆	 DB2 database system administrator responsible for configuring and using the 
databases. 

◆ NetBackup system administrator responsible for configuring NetBackup. 

A system administrator is defined as a person with system administrator privileges 
and responsibilities. 

This guide assumes: 

◆ A basic understanding of system administration. 

◆ A working understanding of the NetBackup client and server software. 

◆ A familiarity with the information covered in the following NetBackup manuals: 

◆ NetBackup User’s Guide for UNIX 

◆	 NetBackup System Administrator’s Guide for UNIX, Volumes I and II or NetBackup 
System Administrator’s Guide for Windows, Volumes I and II 

◆ NetBackup Troubleshooting Guide for UNIX and Windows. 

◆ A thorough understanding of the following DB2 database topics: 

◆ DB2 Administration 

◆ DB2 Commands, particularly DB2 BACKUP, RESTORE, and ROLLFORWARD. 

◆ DB2 User Exit Program 

What Is In This Guide? 
This guide is organized as follows: 

◆	 The Introduction provides an overview of terminology for NetBackup for DB2 on 
UNIX. 

◆	 The Installation chapter explains how to install NetBackup for DB2 on UNIX on your 
system. 

◆	 The Configuration chapter explains how to configure your system to use NetBackup 
for DB2 on UNIX. This information supplements the NetBackup System 
Administrator Guides. 

◆	 Using NetBackup for DB2 on UNIX explains how to use this product to backup and 
restore your databases. This information supplements the NetBackup manuals. 
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◆	 Using NetBackup for DB2 with SAP provides guidelines for using SAP, DB2, and 
NetBackup together. 

◆	 NetBackup for DB2 with Advanced Client explains how to use NetBackup for DB2 
with NetBackup Advanced Client to perform snapshot backups of your DB2 
database. 

◆ Troubleshooting provides troubleshooting information. 

The Configuration for a DB2 EEE (DPF) Environment appendix contains special 
instructions for DB2 databases in a DB2 Enterprise - Extended Edition (EEE) or Database 
Partitioning Feature (DPF) environment. 

Getting Help 
VERITAS offers you a variety of support options. 

Accessing the VERITAS Technical Support Web Site 

The VERITAS Support Web site allows you to: 

◆	 obtain updated information about NetBackup for DB2, including system 
requirements, supported platforms, and supported peripherals 

◆ contact the VERITAS Technical Support staff and post questions to them 

◆ get the latest patches, upgrades, and utilities 

◆ view the NetBackup for DB2 Frequently Asked Questions (FAQ) page 

◆ search the knowledge base for answers to technical support questions 

◆ receive automatic notice of product updates 

◆ find out about NetBackup for DB2 training 

◆ read current white papers related to NetBackup for DB2 

The address for the VERITAS Technical Support Web site follows: 

◆ http://support.veritas.com 

Subscribing to VERITAS Email Notification Service 

Subscribe to the VERITAS Email notification service to be informed of software alerts, 
newly published documentation, Beta programs, and other services. 

Go to http://support.veritas.com. Select a product and click “E-mail Notifications” on the 
right side of the page. Your customer profile ensures you receive the latest VERITAS 
technical information pertaining to your specific interests. 
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Accessing VERITAS Telephone Support 

Telephone support for NetBackup for DB2 is only available with a valid support contract. 
To contact VERITAS for technical support, dial the appropriate phone number listed on 
the Technical Support Guide included in the product box and have your product license 
information ready for quick navigation to the proper support group. 

▼ To locate the telephone support directory on the VERITAS web site 

1. Open http://support.veritas.com in your web browser. 

2.	 Click the Phone Support icon. A page that contains VERITAS support numbers from 
around the world appears. 

Accessing VERITAS E-mail Support 

▼	 To contact support using E-mail on the VERITAS web site 

1. Open http://support.veritas.com in your web browser. 

2.	 Click the E-mail Support icon. A brief electronic form will appear and prompt you to: 

◆ Select a language of your preference 

◆ Select a product and a platform 

◆ Associate your message to an existing technical support case 

◆ Provide additional contact and product information, and your message 

3. Click Send Message. 

Contacting VERITAS Licensing 

For license information call 1-800-634-4747 option 3, fax 1-650-527-0952, or e-mail 
amercustomercare@veritas.com. 
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NetBackup for DB2 Manuals 
The following manuals, along with the online help, are included in the NetBackup for 
DB2 documentation set. For a more detailed listing of NetBackup documents, refer to 
NetBackup Release Notes for UNIX and Windows. 

If you have a UNIX server, refer to these documents: 

◆ VERITAS NetBackup System Administrator's Guide for UNIX, Volume I 

NetBackup_AdminGuideI_UNIXServer.pdf 

Explains how to configure and manage NetBackup on a UNIX server, including 
managing storage units, backup policies, catalogs and host properties. 

◆ VERITAS NetBackup System Administrator's Guide for UNIX, Volume II 

NetBackup_AdminGuideII_UNIXServer.pdf 

Explains additional NetBackup features such as notify scripts, enhanced 
authorization and authentication, and role-based security. The guide also discusses 
using NetBackup with AFS, Intelligent Disaster Recovery (IDR), and the BE Tape 
Reader. 

◆ NetBackup Media Manager System Administrator’s Guide for UNIX 

Explains how to configure and manage the storage devices and media on UNIX 
NetBackup servers. Media Manager is part of NetBackup. 

◆ VERITAS NetBackup Troubleshooting Guide for UNIX and Windows 

Provides troubleshooting information for UNIX- and Windows-based NetBackup 
products, including Media Manager. 

If you have a Windows server, refer to these documents: 

◆ VERITAS NetBackup System Administrator’s Guide for Windows, Volume I 

NetBackup_AdminGuideI_WinServer.pdf 

Explains how to configure and manage NetBackup on a Windows server, including 
managing storage units, backup policies, catalogs and host properties. 

◆ VERITAS NetBackup System Administrator’s Guide for Windows, Volume II 

NetBackup_AdminGuideII_WinServer.pdf 

Explains additional NetBackup features such as notify scripts, enhanced 
authorization and authentication, and role-based security. The guide also discusses 
using NetBackup with AFS, Intelligent Disaster Recovery (IDR), and the BE Tape 
Reader. 

◆ NetBackup Media Manager System Administrator’s Guide for Windows 
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Explains how to configure and manage the storage devices and media on Windows 
NetBackup servers. Media Manager is part of NetBackup. 

◆ VERITAS NetBackup Troubleshooting Guide for UNIX and Windows 

Provides troubleshooting information for UNIX- and Windows-based NetBackup 
products, including Media Manager. 

DB2 Manuals 
For IBM DB2, you may also need the following manuals from IBM: 

◆ IBM DB2 Universal Database for UNIX Quick Beginnings 

◆ IBM DB2 Universal Database for UNIX Command Reference 

◆ IBM DB2 Universal Database Data Recovery and High Availability Guide and Reference 

Glossary 
If you encounter unfamiliar terminology, consult the NetBackup online glossary. The 
glossary contains terms and definitions for NetBackup and all additional NetBackup 
options and agents. 

The NetBackup online glossary is included in the NetBackup help file. 

▼ To access the NetBackup online glossary 

1. In the NetBackup Administration Console, click Help > Help Topics.


2. Click the Contents tab.


3. Click Glossary of NetBackup Terms.


Use the scroll function to navigate through the glossary.


Accessibility Features 
NetBackup contains features that make the user interface easier to use by people who are 
visually impaired and by people who have limited dexterity. Accessibility features 
include: 
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◆	 Support for assistive technologies such as screen readers and voice input (Windows 
servers only) 

◆	 Support for keyboard (mouseless) navigation using accelerator keys and mnemonic 
keys 

For more information, see the NetBackup System Administrator’s Guide for Windows, 
Volume I or the NetBackup System Administrator’s Guide for UNIX, Volume I. 

Conventions 
The following conventions apply throughout the documentation set. 

Product-Specific Conventions 

The following term is used in the NetBackup for DB2 5.1 documentation to increase 
readability while maintaining technical accuracy. 

◆ Microsoft Windows, Windows 

Terms used to describe a specific product or operating system developed by 
Microsoft, Inc. Some examples you may encounter in NetBackup documentation are, 
Windows servers, Windows 2000, Windows Server 2003, Windows clients, Windows 
platforms, or Windows GUI. 

When Windows or Windows servers is used in the documentation, it refers to all of 
the currently supported Windows operating systems. When a specific Windows 
product is identified in the documentation, only that particular product is valid in that 
instance. 

For a complete list of Windows operating systems and platforms that NetBackup 
supports, refer to the NetBackup Release Notes for UNIX and Windows or go to the 
VERITAS support web site at http://www.support.veritas.com. 

Typographical Conventions 

Here are the typographical conventions used throughout the manuals: 

Conventions 

Convention Description 

GUI Font	 Used to depict graphical user interface (GUI) objects, such as fields, 
listboxes, menu commands, and so on. For example: Enter your 
password in the Password field. 
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Conventions  <Variable/Emphasis>(Continued) 

Convention Description 

Italics
 Used for placeholder text, book titles, new terms, or emphasis. Replace 
placeholder text with your specific text. For example: Replace filename 
with the name of your file. Do not use file names that contain spaces. 

This font is also used to highlight NetBackup server-specific or operating 
system-specific differences. For example: This step is only applicable for 
NetBackup Enterprise Server. 

Code	 Used to show what commands you need to type, to identify pathnames 
where files are located, and to distinguish system or application text that 
is displayed to you or that is part of a code example. 

Key+Key	 Used to show that you must hold down the first key while pressing the 
second key. For example: Ctrl+S means hold down the Ctrl key while 
you press S. 

You should use the appropriate conventions for your platform. For example, when 
specifying a path, use backslashes on Microsoft Windows and slashes on UNIX. 
Significant differences between the platforms are noted in the text. 

Tips, notes, and cautions are used to emphasize information. The following samples 
describe when each is used. 

Tip Used for nice-to-know information, like a shortcut. 

Note	 Used for important information that you should know, but that shouldn’t cause any 
damage to your data or your system if you choose to ignore it. 

Caution	 Used for information that will prevent a problem. Ignore a caution at your own 
risk. 

Command Usage 

The following conventions are frequently used in the synopsis of command usage. 

brackets [ ] 

The enclosed command line component is optional. 

Vertical bar or pipe (|) 

Separates optional arguments from which the user can choose. For example, when a 
command has the following format: 
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command arg1|arg2 

In this example, the user can use either the arg1 or arg2 variable. 

Navigating Multiple Menu Levels 

When navigating multiple menu levels, a greater-than sign (>) is used to indicate a 
continued action. 

The following example shows how the > is used to condense a series of menu selections 
into one step: 

❖	 Select Start > Programs > VERITAS NetBackup > NetBackup Administration 
Console. 

The corresponding actions could be described in more steps as follows: 

1. Click Start in the task bar. 

2. Move your cursor to Programs. 

3. Move your cursor to the right and highlight VERITAS NetBackup. 

4.	 Move your cursor to the right. First highlight and then click NetBackup 
Administration Console. 
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Introduction 
1


NetBackup for DB2 integrates the database backup and recovery capabilities of DB2 
commands with the backup and recovery management capabilities of NetBackup. 

This chapter introduces NetBackup for DB2 and how it relates to both DB2 commands 
and NetBackup. Read this chapter for a description of: 

◆ Terminology for NetBackup for DB2 

◆ Features of NetBackup for DB2 

◆ Technical Overview of NetBackup for DB2 
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Terminology for NetBackup for DB2 

NetBackup Terms 
This section describes NetBackup terms as they apply to NetBackup for DB2. 

NetBackup	

NetBackup policy	

NetBackup schedule	

Administrator-directed	
backups	

User-directed backups and 	
restores	

Graphical interfaces	

Media Manager	

Templates	

NetBackup backs up and restores files, directories, raw partitions, and 
databases on client systems that have DB2 databases. 

NetBackup policies define criteria for backups and restores. These 
criteria include storage unit and media to use, backup schedules, 
clients, files to back up, or backup templates or scripts to execute. 

NetBackup schedules control NetBackup operations such as: when 
backups can occur, the type of backup (full, incremental) to perform, 
and how long NetBackup retains the image (retention level). 

NetBackup administrators are able to perform remote backups of all 
files, directories, databases, and raw partitions contained on client 
systems within a client/server network via NetBackup interfaces. 

NetBackup users are able to perform backups of all files, directories, 
databases, and raw partitions contained on client systems within a 
client system. In the case of DB2, user-directed operations are 
performed on the DB2 client via DB2 interfaces. 

Graphical user interfaces are available for both users and 
administrators. 

The Media Manager provides complete management and tracking of 
all devices and media used during backups and restores. 

The NetBackup for DB2 wizards are used to create backup and 
recovery templates used to perform DB2 backup and restore 
operations. These wizards are initiated from the NetBackup Backup, 
Archive, and Restore interface. A shell script should be written for 
situations where a template does not provide all of the required 
functionality. 

For explanations of other NetBackup terms, consult the NetBackup online glossary. For 
instructions, see the “Glossary” section in the Preface. 

NetBackup for DB2 Terms 

Full Backup
 A full backup copies all blocks into the backup. 

(DB2 BACKUP DB SAMPLE) 
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Incremental Backup	

Differential Incremental 	
Backup	

Cumulative Incremental 	
Backup	

Automated Restore	

bpdbsbdb2


An incremental backup is a backup of only those blocks that have 
changed since a previous backup. DB2 allows you to create and 
restore incremental backups of tablespaces and complete databases. 

In a differential incremental backup, you back up all blocks that have 
changed since the most recent full or incremental backup. 

(DB2 BACKUP DB SAMPLE INCREMENTAL DELTA) 

In a cumulative incremental backup, you back up all blocks that have 
changed since the most recent full backup. 

Cumulative incremental backups reduce the work needed for a 
restore by ensuring that you only need one cumulative incremental 
backup at restore time. Cumulative backups typically require more 
space and time than Differential Incremental Backups, however, 
because they contain all modifications since the last full backup. 

(DB2 BACKUP DB SAMPLE INCREMENTAL) 

An automated restore coordinates the restoration of a full backup and 
all associated incremental backups. A single automated restore will 
restore a full backup, an optional cumulative incremental backup, and 
one or more differential incremental backups. 

(DB2 RESTORE DB SAMPLE INCREMENTAL AUTOMATIC) 

NetBackup for DB2 provides a command line utility, bpdpsbdb2, that 
initiates template based user-directed backup and recovery. This 
utility is also used to generate DB2 shell scripts from templates 
created by the Backup Wizard. 

DB2 Database Terms 
This section describes DB2 database terms as they apply to NetBackup for DB2. 

BACKUP DATABASE

command	

RESTORE DATABASE

command	

ROLLFORWARD DATABASE

command	

BACKUP DATABASE is a DB2 UDB command which initiates the 
backup of a database. 

For details, refer to IBM DB2 Universal Database Command Reference. 
RESTORE DATABASE is a DB2 UDB command which initiates the 
restore of a DB2 database. 

For details, refer to IBM DB2 Universal Database Command Reference. 
ROLLFORWARD DATABASE is a DB2 UDB command which initiates 
the rollforward recovery of transactions recorded in database logs. 

For details, refer to IBM DB2 Universal Database Command Reference. 
DB2 script
 A DB2 script contains BACKUP DATABASE or RESTORE DATABASE 

commands. 
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User Exit Program
 A program that manages the backup and recovery of the DB2 
archived logs, used during rollforward recovery. The program is 
called db2uext2. 

Vendor I/O Library
 The Vendor I/O Library contains I/O functions provided by 
NetBackup for DB2 in a shared library. The Vendor I/O Library is 
used by the BACKUP DATABASE and RESTORE DATABASE 
commands to send data buffers between a DB2 database and 
NetBackup. 

UDB Universal Database. 
EEE
 The IBM DB2 Enterprise - Extended Edition environment.  This refers 

to a database that is distributed across multiple hosts, or partitions. In 
a non-EEE environment, the database is typically centralized on a 
single host. 

DPF
 Database Partitioning Feature. This is equivalent to the Extended 
Edition Environment (EEE), where a database is distributed across 
multiple hosts, or partitions. 
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Features of NetBackup for DB2 
This section describes the NetBackup for DB2 main features. 

NetBackup for DB2 main features 

Feature Description 

Media and device 
management 

Scheduling facilities 

Multiplexed backups and 
restores 

Transparent execution of 
both DB2 and regular file 
system backup and 
restore operations 

Sharing the same devices 
and tapes used during 
other file backups 

Centralized and 
networked backup 
operations 

All devices supported by Media Manager are available to 
NetBackup for DB2. 

NetBackup scheduling facilities on the master server can be 
used to schedule automatic and unattended DB2 backups. 

This also lets you choose the times when these operations can 
occur. For example, to prevent interference with normal 
daytime operations, you can schedule your database backups 
to occur only at night. 

NetBackup for DB2 lets you take advantage of NetBackup’s 
multiplexing capabilities. Multiplexing directs multiple data 
streams to one backup device, thereby reducing the time 
necessary to complete the operation. 

All backups and restores are run simultaneously and 
transparently without any action from the NetBackup 
administrator. 

A DB2 administrator can run database backup and restore 
operations through NetBackup or use DB2 commands as if 
NetBackup were not present. 

An administrator or any other authorized user can use 
NetBackup to run database backups and restores. 

It is possible to share the same devices and media used for 
other backups or to give DB2 exclusive use of certain devices 
and media. 

From the NetBackup master server, you can schedule 
database backups or start them manually for any client. The 
DB2 databases can also reside on hosts that are different from 
the devices on which NetBackup stores the backups. 
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NetBackup for DB2 main features 

Feature Description 

Graphical user interfaces	 NetBackup provides the following graphical user interfaces 
for client users and administrators: 

◆ Backup, Archive, and Restore user interface 

◆ NetBackup Administration Console for Java 

◆ NetBackup Administration Console for Windows 

A database administrator or NetBackup administrator can 
start backup or restore operations for DB2 from the 
NetBackup graphical user interface on the master server. 

A database administrator can also use the IBM DB2 Control 
Center or Command Line Processor to start user-directed 
backup and restore operations. 

Parallel backup and NetBackup for DB2 supports the parallel backup and restore 
restore operations	 capabilities of the DB2 commands. This permits the user to 

run more than one tape device at a time for a single DB2 
backup or restore, thereby reducing the time necessary to 
complete the operation. 
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Technical Overview of NetBackup for DB2 
The example network in the following illustration shows the major components in a 
NetBackup for DB2 configuration. 

System containing DB2 database 

NetBackup for DB2 supplies: 

DB2 database software supplies: 

– Commands: 
BACKUP DATABASE, 
RESTORE DATABASE 
ROLLFORWARD DATABASE 

– NBDB2 Vendor I/O Library 
– GUI for browsing databases and creating 

backup and restore templates 
– Sample configuration file 
– Sample script files 
– User-exit program 

Additional required NetBackup software: 

– NetBackup Master Server 
– NetBackup Client 

DB2 database 

NetBackup software: 

– NetBackup Master Server 
– NetBackup Media Server 

(if system is a media server) 

Network (TCP/IP) 

Tape or optical 
storage device 

NetBackup master server 
or remote media server 

The storage devices are connected to the NetBackup master server or a remote media 
server. Both the master server and the remote media server must have NetBackup server 
software installed. 

The host with the DB2 database must be a NetBackup client and have NetBackup for DB2 
installed. 

NetBackup for DB2 Components 
Following are the main components in the NetBackup for DB2 system. 
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NBDB2 Vendor I/O Library 

The NetBackup vendor library is used by DB2 commands when executing backups and 
restores. The location of the vendor library is 

On Solaris and Linux: install_path/NetBackup/bin/nbdb2.so 

On Solaris 64 bit: install_path/NetBackup/bin/nbdb2.so64 

On AIX and HP-UX: install_path/NetBackup/nbdb2.sl 

On AIX and HP-UX 64 bit: install_path/NetBackup/bin/nbdb2.sl64 

(for example, /usr/openv/netbackup/bin/nbdb2.sl). 

The library is called by the DB2 BACKUP and RESTORE commands, with the LOAD 
parameter. For example, 

BACKUP DB SAMPLE … LOAD /usr/openv/netbackup/bin/nbdb2.sl


DB2 User-Exit Program 

A user-exit program is used by DB2 to backup and restore database log files. The location 
of the DB2 user-exit program is <DB2_INSTANCE>/sqllib/adm/db2uext2. The 
user-exit program is invoked by the DB2 BACKUP and ROLLFORWARD commands. For 
example, 

ROLLFORWARD DB SAMPLE … TO END OF LOGS …


Backup and Recovery Wizards 

NetBackup for DB2 provides wizards that enable you to create backup and recovery 
templates. You invoke the wizards by browsing for and selecting a DB2 database object in 
the Backup, Archive, and Restore interface. After you supply the appropriate information 
about the operation, a template is created that can be run immediately or stored on the 
server (for backup templates). You can use the stored backup templates in scheduled 
backups through a NetBackup policy, or to perform manual backups on the NetBackup 
for DB2 client. 

Sample Configuration File 

A NetBackup for DB2 configuration file is used to store backup and restore preferences. 
The vendor library and user-exit program use these settings. The location of the file is 
<DB2_INSTANCE>/db2.conf (for example, /home/db2inst1/db2.conf). This file 
contains various NetBackup settings, like the policy and schedule. 
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Sample Script Files 

NetBackup invokes a script to perform a scheduled backup or restore of a DB2 database. 
The user must customize the provided sample script file(s) for their environment. The 
sample scripts contain DB2 BACKUP or RESTORE commands for use with NetBackup. 

NetBackup for DB2 provides sample scripts in the following location: 

install_path/netbackup/ext/db_ext/db2/scripts


Alternatively, users can create templates using the NetBackup for DB2 GUI. The templates 
can be used in place of scripts. 

NetBackup for DB2 Backup Overview 

Database Backup 

The DB2 user invokes a database backup by using the DB2 Control Center or Command 
Line Processor.  When initiating the backup command, you must specify the location of 
the NBDB2 library. 

A scheduled task within NetBackup can also be used to back up a database. At the 
scheduled time, the NetBackup task will execute a template or script containing the 
necessary DB2 commands to perform a backup. Templates are created using the 
NetBackup for DB2 wizards, while scripts are written by the user to perform the desired 
operations. 

Regardless of the interface used to initiate the backup, DB2 conducts the backup by 
issuing start, write, and end instructions to the NBDB2 library. 

start	 The start instruction causes NBDB2 to verify the backup settings with 
the master server, such as policy, schedule, and client permissions. 
Next, start causes NBDB2 to reserve resources like drives and media on 
the media server. 

write	 The write instruction is then repeatedly issued by DB2, each time 
passing a portion of the backup image. NBDB2 takes the data and 
directs it to the media server for storage. 

end  Finally, the end instruction is issued when DB2 has successfully 
written the entire backup image. NBDB2 informs the media server to 
commit any buffered data, and informs the master server to catalog the 
operation. 
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Log File Archiving 

DB2 uses log files to preserve database transactions that have not been persistently 
recorded in the database. Once all transactions in a log file are persistently recorded, that 
log file can be archived. The DB2 USEREXIT setting enables the use of log files. 

DB2 invokes the user-exit program to archive a log file at these times: 

◆ The "user exits" the database using the DB2 TERMINATE command. 

◆ The log file is full and transactions are being recorded into another log file. 

◆ The DB2 BACKUP command is issued. 

◆ The DB2 ARCHIVE LOG command is issued. 

NetBackup provides a user-exit program for use with DB2. It supports two modes of 
operation: 

◆ Saving archived log files directly to NetBackup. 

◆ Copying archived log files to another directory, for later backup by NetBackup. 

Saving the log files directly to NetBackup is simply the automatic backup of the log file. 
DB2 invokes the NetBackup user-exit program, which initiates a file backup operation. 

Copying the log files to a directory is used in conjunction with a scheduled backup. In this 
case, the NetBackup user-exit program copies the file to an archive directory. Later (for 
example, nightly), a scheduled NetBackup task runs to backup all files in the archive 
directory. After backup, the task can optionally delete these files to free disk space. 

The save and copy methods require different restore procedures, as explained below. 

Incremental Backup of DB2 Databases 

NetBackup for DB2 provides true incremental backups. An incremental backup will 
include only the blocks that have been changed since the most recent backup. 

Refer to the IBM DB2 Universal Database Data Recovery and High Availability Guide and 
Reference for more complete details on the backup and recovery process. 

NetBackup for DB2 Restore Overview 

Database Restore 

The DB2 user invokes a database restore by using the DB2 Control Center or Command 
Line Processor.  When initiating the restore command, the vendor library option must 
specify the location of the NBDB2 library. 
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A scheduled task within NetBackup can also be used to restore a database. At the 
scheduled time, the NetBackup task will execute a template or script containing the 
necessary DB2 commands to perform a restore. Templates are created by the NetBackup 
for DB2 wizard. Scripts are written by the user to perform the desired operations. 

Regardless of the interface used to initiate the restore, DB2 conducts the restore by issuing 
start, read, and end instructions to the NBDB2 library. 

start	 The start instruction causes NBDB2 to verify the restore settings and 
permissions with the master server, and locates the requested image 
within the media server. 

read	 The read instruction is then repeatedly issued by DB2, each time 
requesting a portion of the backup image. NBDB2 reads data from the 
media server and returns it to DB2. 

end	 Finally, the end instruction is issued when DB2 has successfully 
restored the entire image, and NBDB2 informs the media server to 
release the resources. 

Log File Rollforward 

Once the database is successfully restored, transactions recorded in the log files need to be 
re-applied. The DB2 ROLLFORWARD command restores transactions made since the last 
backup. For example, if the backup image was created 10 days ago and restored today, the 
log files are used to restore transactions that occurred after the backup. 

DB2 assumes the active log files are safely preserved on disk. By definition, the active log 
files have never been archived. However, the archived log files need to be restored for the 
rollforward operation. DB2 invokes the user-exit program to restore archived log files. 

If the log files were saved directly to NetBackup, the user-exit program simply initiates a 
file restore operation. DB2 invokes the user-exit program, providing the filename to 
restore. The user-exit program searches the NetBackup catalog for that file. When found, it 
is then restored directly to the DB2 log directory. 

If the log files were first copied to an archive directory and later backed up by a scheduled 
task, the recovery process is a bit different. First, the user must use NetBackup to restore 
all log files created since the database backup image, e.g. 10 days ago. The files must be 
restored to the archive directory, not the DB2 log directory. When the rollforward 
operation is performed, DB2 will instruct the user-exit program to restore a log file. The 
user-exit program simply searches the archive directory for the file. When found, it is then 
copied from the archive directory into the DB2 log directory. 
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Log files saved directly to tape require no user intervention during the recovery. However, 
their sequential recovery can be slow when dealing with numerous, large log files. Log 
files that are first copied and later backed up require some user intervention during the 
recovery. Specifically, you must restore these files prior to the rollforward. Advanced 
users prefer this approach because of performance and flexibility benefits. 

DB2 Commands 
This section describes DB2 commands that interact with NetBackup, and options

important to proper operation. See the DB2 UDB Command Reference for a complete

description of these commands.


Backup


The DB2 BACKUP DATABASE command is used to backup a database to NetBackup.


LOAD <NBDB2 Library Instructs DB2 to use the NBDB2 vendor library when performing the 
Path> backup. 

OPEN (number) 
SESSIONS 

Specifies the number of concurrent data streams used for writing data. 
Use this option if you have multiple backup devices available, or have 
multiplexing enabled in NetBackup. 

WITH (number) BUFFERS Use this option when opening multiple sessions (see above). 

Note The number of buffers must be twice the number of sessions. 

BUFFER size	 Use this option to increase or decrease the buffer size if necessary. 
Increased size can benefit performance, while decreased size may be 
necessary if using numerous buffers. DB2 recommends the size be a 
multiple of the extent size. The DB2 DFT_EXTENT_SZ setting defines 
the default extent size. 

WITHOUT PROMPTING	 This option is required for unattended backups, and must be specified 
in backup scripts executed by NetBackup. 

INCREMENTAL Use this option to perform a cumulative backup. 

INCREMENTAL DELTA Use this option to perform a differential backup. 

ONLINE	 Use this option to back up “hot” or active databases. The DB2 
USEREXIT setting must be enabled for online backups. 
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Restore


The DB2 RESTORE DATABASE command is used to restore a database from NetBackup.


LOAD <NBDB2 Library Instructs DB2 to use the NBDB2 vendor library when performing the 
Path> restore. 

OPEN (number) Typically, you should specify the same number of sessions used during 
SESSIONS the backup. Using fewer sessions is allowed, but may degrade overall 

restore performance. Specifying more sessions has no benefit. 

WITH (number) BUFFERS Use this option when opening multiple sessions (see above). 

Note The number of buffers must be twice the number of sessions. 
Using fewer buffers can degrade performance, or cause the 
restore to fail when reading multiplexed images. 

BUFFER size	 Use this option to increase or decrease the buffer size if necessary. 
Increased size can benefit performance, while decreased size may be 
necessary if using numerous buffers. DB2 will alter the actual size to be 
a multiple of the size used during the backup. 

WITHOUT PROMPTING	 This option is required for unattended restores, and must be specified 
in backup scripts executed by NetBackup. 

INCREMENTAL	 When using this option, DB2 may not read the entire image from 
NetBackup media. Consequently, NetBackup will log an error in the 
Activity Monitor, which can safely be ignored. 

AUTOMATIC Use this option to restore a series of full and incremental images. 

HISTORY FILE	 When using this option, DB2 may not read the entire image from 
NetBackup media. Consequently, NetBackup will log an error in the 
Activity Monitor, which can safely be ignored. 

ROLLFORWARD 

The DB2 ROLLFORWARD command is used to recover a database by applying transactions 
that have been previously logged into a file. 

When a database or tablespace recovery is performed, DB2 invokes the user-exit program 
named db2uext2 to restore any archived log files. NetBackup for DB2 provides a custom 
db2uext program that restores the files from NetBackup media into the DB2 log 
directory. Once the log file is restored, DB2 applies the transactions within that file to 
satisfy the rollforward request. 
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Load


The DB2 LOAD command is used to load data into a database table.


COPY YES	 Instructs DB2 to copy (back up) the loaded data to NetBackup. The data 
will not be recorded in the transaction log. If a ROLLFORWARD 
command is performed later, the loaded data will be automatically 
restored from NetBackup. In other words, the transaction log records 
that the loaded data resides in a NetBackup backup image. 

LOAD <NBDB2 Library Instructs DB2 to back up the loaded data using the NBDB2 vendor 
Path> library. 

OPEN (number) Specifies the number of concurrent data streams used for writing data. 
SESSIONS	 Use this option if you have multiple backup devices available, or have 

multiplexing enabled in NetBackup. 
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Installation 
2


This chapter describes the NetBackup for DB2 on UNIX installation and setup procedures. 
It includes a section on installation prerequisites. 

▼ To locate the latest Database Agent information on the VERITAS support web site 

1. Go to the VERITAS support web page: http://www.support.veritas.com. 

2.	 From the Select Product Family list, choose NetBackup Products. The Select Product 
window refreshes showing a list of NetBackup products. 

3.	 Select one of the NetBackup products. The page refreshes and displays a search 
window with four tabs. 

4. Select 5.1 in the Product Version drop-down field. 

5. Select a Product Platform. 

6.	 Click the Compatibility tab. The page refreshes showing documents that contain 
compatibility information. 

7.	 Click on the title of the document link for NetBackup Database Agent Compatibility 
List. A document appears that contains a downloadable file that enables you to view 
the supported database spreadsheet for this release. 

At the time of this release, NetBackup for DB2 supports the following DB2 Universal 
Database Versions: 

◆ 7.1.x FixPak 10a or later 

◆ 7.2.x FixPak 10a or later 

◆ 8.1.x FixPak 3 or later 

NetBackup for DB2 supports all UNIX and Windows Editions of DB2, including 
EEE/DPF. 
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Installation Prerequisites 
Before installing NetBackup for DB2 on UNIX, be sure you have completed the following 
procedures: 

❖	 Install the DB2 vendor software on the client where you will be backing up the 
databases. 

❖ Install the NetBackup server software on the server. 

The NetBackup server platform can be any of those that NetBackup supports. 

Refer to the NetBackup Installation Guide for UNIX or the NetBackup Installation Guide 
for Windows. 

❖	 Install the NetBackup client software on the client where you will be backing up the 
databases. 

Refer to the NetBackup Installation Guide for UNIX for installation instructions. 

Caution	 In an DB2 EEE environment, the NetBackup client software must be installed 
on every node/client used by DB2. 

See the following for more details: 

◆ IBM DB2 Universal Database Quick Beginnings 

Now you are ready to install NetBackup for DB2 on UNIX on the client where you will be 
backing up the databases. Refer to the next section for detailed instructions on installing 
NetBackup for DB2 on UNIX. 

Guidelines for Installing NetBackup for DB2 on UNIX in a 
Cluster 

◆	 Prior to installing NetBackup for DB2 on UNIX, the NetBackup server must be 
installed and configured to work in a cluster. (This is accomplished by following the 
instructions in the NetBackup Installation Guide for UNIX, including running the 
cluster_config script after the NetBackup server software has been installed.) 

◆	 Commands such as bpplclients and update_dbclients must be run from the 
active NetBackup node. If you are pushing the database agent software to clients 
located in a cluster, specify the individual node names (not virtual names) in the list of 
clients. 
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◆	 If installing NetBackup for DB2 on UNIX on a clustered NetBackup server, freeze the 
active NetBackup node before beginning the installation. Install on all the inactive 
nodes, then install on the active node. After you successfully install on the active 
node, unfreeze this node. 

◆	 The cluster_config script only needs to be run after the NetBackup server 
software has been installed. You do not need to run this script after installing 
NetBackup for DB2 on UNIX on a NetBackup server or if you wish to install 
NetBackup for DB2 on UNIX on a machine on which only the NetBackup client is 
installed. 
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Installing NetBackup for DB2 on UNIX 
There are two ways to install database agent software. 

◆	 Remote installation: Loads the software on a master server. The user then pushes the 
database software out to affected clients. 

Refer to the following section. 

◆ Local installation: Loads and installs the software only to the local machine. 

Refer to “Local Installation of NetBackup for DB2 on UNIX” on page 23. 

Remote Installation of NetBackup for DB2 on UNIX 
During a remote installation, NetBackup for DB2 on UNIX files are loaded onto the 
current machine, which must be a UNIX master server. The software is then distributed to 
the clients and installed. 

Note	 In a clustered environment, the capability to push client software is only available 
from the active node. 

Installation Requirements 

◆	 The version of the NetBackup client and the version of NetBackup for DB2 on UNIX 
must be the same (for example, 5.1). 

◆ There must be adequate disk space on each client that will receive the software. 

Less than one megabyte of additional disk space is required in the client’s 
install_path/netbackup directory. However, more disk space may be necessary 
at run time. 

◆ NetBackup version 5.1 software is installed and operational on each DB2  host. 

This also means that the directory install_path/netbackup already exists on 
each DB2 host. 

◆ DB2 database instances exist on the DB2 host. 

◆	 In a clustered environment, NetBackup server software has been installed and 
configured to work in a cluster. (This is accomplished by following the instructions in 
the NetBackup Installation Guide for UNIX, including running the cluster_config 
script after the NetBackup server software is installed.) 
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Remote Installation Instructions 

▼ To perform a remote installation 

1.	 If installing NetBackup for DB2 on UNIX on a clustered NetBackup server, first refer 
to the “Guidelines for Installing NetBackup for DB2 on UNIX in a Cluster” earlier in 
this chapter. 

2.	 Log in as the root user on the server. 

If you are already logged in, but are not the root user, run the following command. 

su - root


3.	 Make sure a valid license key for NetBackup for DB2 on UNIX has been registered. To 
view or add license keys, perform one of the following: 

◆ Run the following command: 

install_path/netbackup/bin/admincmd/get_license_key. 

◆ Open the NetBackup Administration Console and choose Help > License Keys. 

4. Insert the CD-ROM into the drive. 

5.	 Change the working directory to the CD-ROM directory. 

cd /CD_mount_point 

6.	 Load the software on the server by executing the install script. 

./install 

a.	 Select the NetBackup Database Agent Software option. 

The following prompt appears: 

Do you want to do a local installation? (y/n) [n]


b.	 Answer n. 

You are presented with a menu of all database agents available on the CD-ROM. 

c. Select the NetBackup for DB2 option. 

d.	 Enter q to quit selecting options. 

A prompt appears asking if the list is correct. 

e. Answer y. 
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The install script identifies the types of client software loaded during the 
installation of the NetBackup server. By default, any matching NetBackup for 
DB2 on UNIX software is automatically loaded. If there are more platforms 
available, the script displays a menu giving you the opportunity to add more 
client types to the default list. Once the list is complete, database agent version 
files, compressed tar files and the install_dbext script are copied to directory 
install_path/netbackup/dbext. 

7.	 Distribute and install the NetBackup for DB2 on UNIX software on each client as 
described in the next sections. 

Note	 In a clustered environment, the capability to distribute client software is only 
available from the active node. 

There are two types of installation processes. 

◆	 initial install: Use an initial install if the clients you intend to update have not been 
added to policies of type DB2. 

◆	 upgrade install: Use an upgrade install if all the clients you intend to update 
already have been added to policies of type DB2. 

Note	 The NetBackup version level (for example, 5.1) running on the clients you wish to 
update must be the same as the version level of the NetBackup for DB2 on UNIX 
being installed. 

Initial Installation on Clients 

▼ To perform an initial install on the clients 

1.	 Run the following command to create a file containing a list of clients currently 
configured in the NetBackup database. 

cd install_path/netbackup/bin

./admincmd/bpplclients -allunique -noheader > filename


where filename is the name of the file to contain the list of unique clients. If no 
clients have been configured in the NetBackup database, and therefore filename is 
empty, create filename using the same format as that generated by bpplclients. 

bpplclients generates output in following format: 

hardware operating_system client_name 
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where: 

hardware is the hardware name. For example, execute the ls command in 
directory install_path/netbackup/client. 

operating_system is the operating system name. For example, execute the ls 
command in directory install_path/netbackup/client/hardware. 

client_name is the name of the client. 

For example, the contents of filename might look like this: 

Solaris Solaris8 curry

RS6000 AIX4.3.3 cypress

Linux RedHat2.4 bumper


2. Edit filename. 

This is an optional step. Use it if the contents of filename need to be changed. Edit 
filename to contain only those clients you wish to update with NetBackup for DB2 on 
UNIX software. 

Note	 If you are pushing the database agent software to clients located in a cluster, specify 
the hostnames of the individual nodes (not virtual names) in the list of clients. 

3. Specify filename in the update_dbclients command. 

For example: 

cd install_path/netbackup/bin 
./update_dbclients DB2 -ClientList filename 

Only clients listed in filename are updated. 

Note	 If the receiving client is configured as an HP-UX11.00, HP-UX11.11, Solaris7, 
Solaris8, Solaris9, AIX4.3.3, or AIX5 machine, both the 32-bit and 64-bit versions of 
NetBackup for DB2 on UNIX will be installed. 

Upgrade Installation on Clients 

▼	 To perform an upgrade installation on the clients 

1. Execute the following command. 

cd install_path/netbackup/bin

./update_dbclients DB2 ALL ALL
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This command looks at all possible clients and updates only the clients currently in 
the DB2 policy type. 

Instead of ALL ALL, you may use -ClientList filename as explained in “Initial 
Installation on Clients” on page 20. 

Note If you are pushing the database agent software to clients located in a cluster, specify 
the hostnames of the individual nodes (not virtual names) in the list of clients. 

Note	 If the receiving client is configured as an HP-UX11.00, HP-UX11.11, Solaris7, 
Solaris8, Solaris9, AIX4.3.3, or AIX5 machine, both the 32-bit and 64-bit versions of 
NetBackup for DB2 on UNIX will be installed. 

Note	 With an initial or upgrade install, some clients may be skipped and not updated. 
Possible reasons are: 
- the client is a PC client (which cannot be updated from a UNIX server) 
- NetBackup for DB2 on UNIX does not support that client's platform type 
- the NetBackup for DB2 on UNIX software for that client type was not loaded onto 
the server in step 6 of the “Remote Installation Instructions” on page 19 
- (if using the ALL ALL method) the client does not belong to the DB2 policy type 
All skipped clients are available in a file whose name is displayed by 
update_dbclients. 

The number of updates required to distribute the software to the clients is displayed.


If more than one update will occur, you will see the following prompt:


Enter the number of simultaneous updates you wish to take place. 1 - max dflt


(must be in the range of 1 to max; default: dflt). 

where: 

max is the maximum number of simultaneous updates that is allowed. The value 
displayed ranges from 1 to 30. 

dflt is the default number the program uses if you press Enter. The value 
displayed ranges from 1 to 15. 

For example, if three client updates will be performed, the max and dflt values shown 
would be 3. If 50 client updates will be performed, the max value shown would be 30 
and the dflt value shown would be 15. 

update_dbclients starts the number of updates that you specify. If this number is 
less than the total number of client updates to be performed, new updates start as the 
previous updates finish until all of the updates have been completed. 

Based on your answer, the time it will take to update the clients is displayed, followed 
by this question: 
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Do you want to upgrade the clients now? (y/n) [y]


2. Enter y or n for the prompt. 

If you answer n, update_dbclients quits and leaves the list of clients it would 
have updated in a file. This file can later be used by the -ClientList parameter 
mentioned previously. 

Answer y to continue the installation process. 

If the update_dbclients command was successful in distributing the software to the 
client, it automatically runs the install_dbext script on the client. If install_dbext 
has successfully completed, there will be a version file in directory 
install_path/share that contains the version of NetBackup for DB2 on UNIX that 
was installed. The update_dbclients command displays a note on whether the update 
was successful for each client. When the update_dbclients command has completed, 
it displays a file name that contains a complete log of what happened for each client. If the 
update failed for any client, the log file should be examined to determine the problem. 

Local Installation of NetBackup for DB2 on UNIX 
During a local installation, the NetBackup for DB2 on UNIX files are extracted and 
installed. The local machine can be a client or a master server that also happens to be a 
client. 

Installation Requirements 

◆	 The version of the NetBackup client and the version of NetBackup for DB2 on UNIX 
are the same (for example, 5.1). 

◆ The local machine must have adequate disk space. 

Less than one megabyte of additional disk space is required in the 
install_path/netbackup directory. However, more disk space may be necessary 
at run time. 

◆ NetBackup version 5.1 client software is installed and operational. 

This also means that the install_path/netbackup directory already exists. 

◆ DB2 database instances exist on the DB2 host. 

◆	 In a clustered environment, NetBackup server has been installed and configured to 
work in a cluster. (This is accomplished by following the instructions in the NetBackup 
Installation Guide for UNIX, including running the cluster_config script after 
installing the NetBackup server software.) 
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Local Install Instructions 

▼	 To install NetBackup for DB2 on UNIX to the local machine 

1. Log in as the root user on the machine. 

If you are already logged in, but are not the root user, run the following command. 

su - root


◆ If the local machine is a client, go to step 3.


◆ If the local machine is a server, go to step 2.


2.	 Make sure a valid license key for NetBackup for DB2 on UNIX has been registered. In 
a NetBackup server clustered environment, the license key must be registered on each 
node. To view or add license keys, perform one of the following: 

◆	 Run the command 
install_path/netbackup/bin/admincmd/get_license_key. 

◆ Open the NetBackup Administration Console and choose Help > License Keys. 

3. Insert the CD-ROM into the drive. 

4.	 Change the working directory to the CD-ROM directory. 

cd /CD_mount_point 

5. Load and install the software by executing the install script. 

Note	 It is expected that the NetBackup version level (for example, 5.1) running on the 
local machine matches the version level of the database agent being installed. 

./install


a.	 Select the NetBackup Database Agent Software option. 

The following prompt appears: 

Do you want to do a local installation? (y/n) [n]


b.	 Answer y. 

You are presented with a menu of all database agents available on the CD-ROM. 

c. Select the NetBackup for DB2 option. 

d. Enter q to quit selecting options. 
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A prompt appears asking if the list is correct. 

e. Answer y. 

The following actions occur: 

◆	 The version file, compressed tar file and install_dbext script are loaded to 
directory install_path/netbackup/dbext. 

◆ The install script automatically executes the install_dbext script. 

◆	 If the receiving client is configured as an HP-UX11.00, HP-UX11.11, Solaris7, 
Solaris8, Solaris9, AIX4.3.3, or AIX5 machine, both the 32-bit and 64-bit 
versions of NetBackup for DB2 on UNIX will be installed. 

◆	 If install_dbext has successfully completed, there will be a version file in 
directory install_path/share that contains the version of NetBackup for 
DB2 on UNIX that was installed and an installation timestamp. 

f. Enter q to quit from the script. 
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Specifying the DB2 Home Path 
The db2uext user-exit program is installed into 
install_path/netbackup/bin/db2uext2. DB2 expects the db2uext2 executable to 
reside with the DB2 UNIX $PATH. This can be accomplished by running the 
db2_config tool provided with NetBackup for DB2. This must be performed after 
installing NetBackup for DB2, and whenever a new DB2 instance is created. 

▼ To specify the DB2 Home Path 

1.	 Change to the following directory: 

/usr/openv/netbackup/bin 

2.	 Run the setup command: 

./db2_config 

The following appears: 

Please specify the DB2 instance home path name:


3.	 Supply the appropriate home path name, and press Enter. 

The following appears: 

Do you have other DB2 instances? (y/n) [n] 


4.	 Add other DB2 instances as appropriate, or enter n if you are finished. 

The setup step is complete. 

Adding New DB2 Instances 
If you add a new DB2 instance after NetBackup for DB2 on UNIX has been installed, 
follow the procedure described in “Specifying the DB2 Home Path” on page 26. This 
ensures that all new database instances will be included in the NetBackup for DB2 backup 
operations. 
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Before attempting to configure NetBackup for DB2, complete the installation procedure as 
described in “Installation” on page 15. 

The following steps outline the configuration procedure. 

1. Configuring Media Using Media and Device Management 

2. Setting the Maximum Jobs Per Client Property 

3. Configuring a NetBackup Policy 

4. Configuring the Run-Time Environment 

5. Creating Templates and Shell Scripts 

6. Testing NetBackup for DB2 Configuration Settings 

The following sections in this chapter describe each of these steps in detail. 

To configure NetBackup for DB2 from a Windows NetBackup server, see “Configuration 
Using the NetBackup Administration Console for Windows” on page 28. 

To configure NetBackup for DB2 from a UNIX NetBackup server, see “Configuration 
Using the NetBackup Administration Console for UNIX” on page 46. 
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Configuration Using the NetBackup Administration 
Console for Windows 

Although the database agent is installed on the NetBackup client, some configuration 
procedures are performed using the NetBackup Administration Console on the server. 

These procedures include: 

◆ Configuring media using Media and Device Management 

◆ Setting the Maximum Jobs per Client property 

◆ Configuring a NetBackup policy 

◆ Testing NetBackup for DB2 configuration settings 

See the next section for instructions on starting the NetBackup Administration Console. 

▼ To launch the NetBackup Administration Console for Windows 

1. Log on to the server as administrator. 

2.	 Choose Start > Programs > VERITAS NetBackup > NetBackup Administration 
Console. 
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The NetBackup Administration Console is displayed. 

Configuring Media Using Media and Device Management 
Use the Media and Device Management (Media Manager) to configure media for a 
NetBackup for DB2 configuration. Refer to the NetBackup Media Manager System  
Administrator’s Guide for more information. 

The number of volumes required will depend on the devices used, the size of the DB2 
databases that you are backing up, and the frequency of backups. 

Setting the Maximum Jobs Per Client Property 
The Maximum jobs per client attribute value is figured with the following formula. 

Maximum Jobs per Client = Number of Sessions x Number of Policies 

Where: 

◆	 Number of Session is the number of backup sessions between the backup server and 
NetBackup on the client. Each separate session starts a new backup job on the client. 
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◆	 Number of Policies is the number of policies that may back up this client at the same 
time. This number can be greater than one. For example, a client may be in two 
policies in order to back up two different databases. These backup windows may 
overlap. 

Tip	 To avoid any problems, we recommend that you enter a high enough value for the 
Maximum jobs per client property to meet the number of jobs executed by DB2. 

▼ To set the Maximum jobs per client property using the Windows console 

1. In the left pane of the NetBackup Administration Console, expand Host Properties. 

2. Select Master Server. 

3.	 In the right pane, double-click on the server icon. 

The Master Server Properties dialog is displayed. 

4. In the Master Server Properties dialog, click Global Attributes. 

The default value is 1 for Maximum jobs per client. 

5. Change the Maximum jobs per client value to 99. 
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If you prefer to enter a lower value, calculate the value equal to the maximum number 
of backups allowed per client using the formula provided above. 

Configuring a NetBackup Policy 
A NetBackup policy defines the backup criteria for a specific group of one or more clients. 
These criteria include: 

◆ storage unit and media to use 

◆ backup schedules 

◆ clients to be backed up 

◆ script files to be executed on the clients 

To use NetBackup for DB2, at least one DB2 policy with the appropriate schedules needs 
to be defined. A configuration can have a single policy that includes all clients or there can 
be many policies, some of which include only one client. 

Most requirements for DB2 policies are the same as for file system backups. In addition to 
the attributes described here, there are other attributes for a policy to consider. Refer to the 
NetBackup System Administrator’s Guide for Windows, Volume I or NetBackup System  
Administrator’s Guide for UNIX, Volume I for detailed configuration instructions and 
information on all the attributes available. 

DB2 Environments 

In general, the following NetBackup configuration is required to use NetBackup for DB2: 

◆ To back up the DB2 Database: 

Create a DB2 database policy with an Application Backup schedule. 

◆ To schedule a DB2 Backup using NetBackup: 

Create a DB2 database policy with an Automatic Full, Automatic Differential 
Incremental, or Automatic Cumulative Incremental Backup schedule. 

◆ To back up the DB2 Archive Log files: 

Create a Standard file policy with a User Backup schedule. 

In most DB2 environments, a single DB2 policy can be used. However, in a DB2 EEE 
environment, a minimum of two (2) DB2 policies are needed: one for the DB2 catalog 
node(s), and another for the non-catalog nodes. In any DB2 environment where 
USEREXIT is enabled, a Standard file policy is required. 
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The following sections describe how to create the NetBackup policies and schedules for 
these environments. For DB2 EEE users, see “Configuration for a DB2 EEE (DPF) 
Environment” on page 143. 

Note	 The Media Manager must be configured and a Storage Unit defined before a policy 
can be added. 

Adding New Policies 

Use this procedure when configuring a policy from a Windows server or from a 
NetBackup Remote Administration Console host. 

▼ To add a new policy 

1. Log on to the server as administrator. 

2. Start the NetBackup Administration Console. 

3.	 If your site has more than one master server, choose the one where you want to add 
the policy. 

4.	 In the left pane, right-click Policies and choose New Policy. 

The Add a New Policy dialog is displayed. 

a. In the Policy name box, type a unique name for the new policy. 

b.	 Choose whether to use the wizard for configuring the policy. The wizard guides 
you through most of the setup process and simplifies it by automatically choosing 
default values that are good for most configurations. If necessary, you can change 
the defaults later by editing the policy. You will need to manually add entries to 
the Backup Selections list after completing the wizard. 

◆	 To use the wizard, select the Use Backup Policy Configuration Wizard box 
and click OK. The wizard starts and you create the policy by following the 
prompts. When prompted, select the DB2 policy type. 
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Note	 The DB2 policy type will not appear in the drop-down list unless your server has a 
license key for NetBackup for DB2. 

◆	 If you require more control over the settings than the wizard provides, then 
do not select the Use Backup Policy Configuration Wizard box and proceed 
to step 5. 

5.	 Click OK. 

A dialog is displayed in which you can specify the general attributes for the policy. 

6. From the Policy Type box, select the DB2 policy type. 

7.	 Complete the entries on the Attributes tab as explained in “Description of 
Attributes.” 

8.	 Add other policy information: 

◆ To add schedules, see “Adding New Schedules.” 

◆ To add clients, see “Adding Clients to a Policy.” 
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◆	 To add templates or scripts to the Backup Selections list, see “Specifying the List 
of Backup Selections.” 

9. Click OK. The new policy is created. 

Description of Attributes 

With a few exceptions, NetBackup manages a database backup like a file system backup. 
Policy attributes that are different for DB2 backups are explained below. 

Your other policy attributes will vary according to your specific backup strategy and 
system configuration. Consult the NetBackup System Administrator’s Guide for Windows, 
Volume I or NetBackup System Administrator’s Guide for UNIX, Volume I for detailed 
explanations of the policy attributes. 

Description of Policy Attributes 

Attribute Description 

Policy type	 Determines the type of clients that can be in the policy and in some cases 
the types of backups that can be performed on those clients. 
To use NetBackup for DB2, you must have defined at least one DB2 policy. 

Keyword phrase to For NetBackup for DB2, the keyword phrase entry is ignored. 
associate with the 
backup 

Advanced Client	 See the “Using NetBackup for DB2 with Advanced Client” chapter for 
information on configuring policies for snapshot methods. 

Adding New Schedules 

Each policy has its own set of schedules. These schedules control initiation of automatic 
backups and also specify when user operations can be initiated. 

A DB2 backup requires an Application Backup schedule, which is created  automatically 
when you create a DB2 policy. The Application Backup schedule is used to initiate and 
manage the backup operation. You also need one or more Automatic Backup schedules, if 
you plan to have NetBackup perform automatic, scheduled backups. 

The following procedures explain how to configure the required schedule types, and how 
to add new schedules. The procedures start on the Policy dialog. To see the Policy dialog, 
double-click the policy name in the Policies list of the NetBackup Administration Console. 
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▼ To configure an Application Backup schedule 

1. On the Policy dialog, click the Schedules tab. 

2. Double-click on the schedule named Default-Application-Backup. 

A dialog is displayed. 

All DB2 database operations are performed through NetBackup for DB2 using an 
Application Backup schedule. This includes those backups started automatically. 

You must configure an Application Backup schedule for each DB2 policy you create. If 
you do not do this, you will not be able to perform a  backup. To help satisfy this 
requirement, an Application Backup schedule named Default-Application-Backup is 
automatically created when you configure a new DB2 policy. 

3. Specify the other properties for the schedule as explained in “Schedule Properties.” 

The backup window for an Application Backup schedule must encompass the time 
period during which all NetBackup jobs, scheduled and unscheduled, will occur. This 
is necessary because the Application Backup schedule starts processes that are 
required for all NetBackup for DB2 backups, including those started automatically. 

For example, assume that you: 

◆	 expect users to perform NetBackup operations during business hours, 0800 to 
1300. 

◆ configured automatic backups to start between 1800 and 2200. 

The Application Backup schedule must have a start time of 0800 and a duration of 14 
hours. 

Example Settings for an Application Backup schedule 

Type of Backup Schedule settings Description Settings 

Application 
Backup 

Retention The length of time backup images 
are stored. 

2 weeks 

Backup Window The time during which a NetBackup 
operation can be performed. 

Sunday through Saturday 

00:00:01 - 23:59:59 

Note	 The Application Backup schedule name must be specified in the 
$DB2_Instance_Home/db2.conf file on the client. 
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Tip	 Set the time period for the Application Backup schedule for 24 hours per day, seven 
days per week. This ensures that your NetBackup for DB2 operations are never 
locked out due to the Application Backup schedule. 

▼ To configure an automatic backup schedule 

1. On the Policy dialog, click the Schedules tab. 

2. Click New. 

A dialog is displayed. The title bar shows the name of the policy to which you are 
adding the schedules. 

3. Specify a unique name for the schedule. 

4. Select the Type of backup. 

For information on the types of backups available for this policy, see “Types of 
Backups.” 

Refer to the following table for example settings for an Automatic Backup schedule. 

Type of Backup Schedule settings Description Settings 

Automatic Full 
Backup 

Retention The length of time to store the 
record of a backup. 

2 months 

Frequency Frequency determines how often 
a backup should be performed 

every month 

Backup Window The time during which a 
NetBackup operation can be 
performed. 

Sunday, 18:00:00 - 22:00:00 

Automatic 
Differential 
Incremental Backup 

Retention The length of time to store the 
record of a backup. 

1 week 

Frequency Frequency determines how often 
a backup should be performed 

every day 

Backup Window The time during which a 
NetBackup operation can be 
performed. 

Monday through Saturday 

18:00:00 - 22:00:00 

Automatic 
Cumulative 
Incremental Backup 

Retention The length of time to store the 
record of a backup. 

1 month 

Frequency Frequency determines how often 
a backup should be performed 

every week 
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Type of Backup Schedule settings Description Settings 

Backup Window The time during which a 
NetBackup operation can be 
performed. 

Sunday 

18:00:00 - 22:00:00 

5. Specify the other properties for the schedule as explained in “Schedule Properties.” 

6. Click OK. 

▼ To add other schedules 

1. In the Policy dialog, click the Schedules tab. 

2. Click New. 

The Change Schedule dialog is displayed. The title bar shows the name of the policy 
to which you are adding the schedule. 

3. Specify a unique name for the schedule. 

4. Select the Type of backup. 

For information on the types of backups available for this policy, see “Types of 
Backups.” 

5. Specify the other properties for the schedule as explained in “Schedule Properties.” 

6. Click OK. 
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To add more schedules, repeat this procedure. Click Cancel to cancel changes that you 
have not yet added and close the dialog. 

Types of Backups 

Caution	 When an automatic schedule is used to invoke a script authored by the user, 
NetBackup cannot provide safeguards preventing unusual behavior, including: 
- a full schedule executing an incremental backup script 
- an incremental schedule executing a full backup script 
- an automatic schedule executing a restore/recovery script 

Whenever possible, using a template instead of a script is recommended, 
because template execution can detect the backup type on the schedule. 
However, the user is still responsible for specifying a template with the correct 
operation type (backup) in the policy. 

Description of Backup Types for DB2 

Application Backup 

Automatic Full 
Backup 

Automatic 
Differential 
Incremental Backup 

Automatic 
Cumulative 
Incremental Backup 

The Application Backup schedule enables user-controlled NetBackup 
operations performed on the client. At least one Application Backup 
schedule type must be configured for each DB2 policy. The 
Default-Application-Backup schedule is automatically configured as an 
Application Backup schedule. 

A full backup copies all blocks into the backup. 

In a differential incremental datafile backup, you back up all blocks that 
have changed since the most recent full or incremental backup. 

In a cumulative incremental backup, you back up all blocks that have 
changed since the most recent full backup. 

Cumulative incremental backups reduce the work needed for a restore by 
ensuring that you only need one cumulative incremental backup at restore 
time. Cumulative backups typically require more space and time than 
Differential Incremental Backups, however, because they contain all 
modifications since the last full backup. 
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Schedule Properties 

Some of the schedule properties have a different meaning for database backups than for a 
regular file system backup. These properties are explained in the following table. 

Other schedule properties vary according to your specific backup strategy and system 
configuration. Consult the NetBackup System Administrator’s Guide for Windows, Volume I or 
NetBackup System Administrator’s Guide for UNIX, Volume I for detailed explanations of the 
schedule properties. 

Description of Schedule Properties 

Property Description 

Type of backup	 Specifies the type of backup that this schedule will control. The selection list 
shows only the backup types that apply to the policy you are configuring. 

For more information see the following section “Types of Backups.” 

Frequency	 This setting is used only for scheduled backups, and not for user-directed 
backups. Frequency specifies the period of time that will elapse until the 
next backup operation can begin on this schedule. For example, if the 
frequency is seven days and a successful backup occurs on Wednesday, the 
next full backup will not occur until the following Wednesday. Normally, 
incremental backups will have a shorter frequency than full backups. 

Calendar	 This setting is used only for scheduled backups, and not for user-directed 
backups. The Calendar option allows you to schedule backup operations 
based on specific dates, recurring week days, or recurring days of the 
month. 
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Description of Schedule Properties (Continued) 

Property Description 

Retention Frequency based scheduling 

The retention period for an Application Backup schedule refers to the 
length of time that NetBackup keeps backup images. 

The retention period for an Automatic Full Backup, Automatic Differential 
Incremental Backup, or Automatic Cumulative Incremental Backup 
schedule controls how long NetBackup keeps records of when scheduled 
backups have occurred. 

The NetBackup scheduler compares the latest record to the frequency to 
determine whether a backup is due. This means that if you set the retention 
period to expire the record too early, the scheduled backup frequency will be 
unpredictable. However, if you set the retention period to be longer than 
necessary, the NetBackup catalog will accumulate unnecessary records. 
Therefore, set a retention period that is longer than the frequency setting for the 
schedule. 

For example, if the frequency setting is set to one week, set the retention 
period to be more than one week. 

Calendar based scheduling 

The retention period for an Application Backup schedule refers to the length 
of time that NetBackup keeps backup images. 

The retention period for an Automatic Full Backup, Automatic Differential 
Incremental Backup, or Automatic Cumulative Incremental Backup 
schedule controls how long NetBackup keeps records of when scheduled 
backups have occurred. However, this setting is not significant for calendar 
based scheduling. 

Multiple copies	 If you are licensed for the Inline Tape Copy feature and wish to specify 
multiple copies for your DB2 policy, configure Multiple copies on the 
Application Backup schedule. 

Adding Clients to a Policy 

The client list is the list of clients on which your DB2 template or scripts are run during an 
automatic backup. A NetBackup client must be in at least one policy but can be in more 
than one. 

This procedure starts in the Policy dialog. To see the Policy dialog, double-click the policy 
name in the Policies list in the NetBackup Administration Console. 

Requirements for clients 

The following software must be installed on the client: 
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◆ DB2 

◆ NetBackup client or server 

◆ NetBackup for DB2


◆ the backup or restore script(s) (unless you are using templates)


▼ To add clients to a policy 

1. In the Policy dialog, click the Clients tab. 

2. Click New. 

3. Enter the name of the client you want to add. 

◆ Type the name into the client list and click OK. 

If NetBackup cannot detect the hardware and operating system, a dialog will be 
displayed so you can specify this information. 

OR 

◆ Click the Browse for Computer button to choose the client from the network: 

If DB2 is installed in a cluster, specify the virtual DB2 name as the client name. 

4.	 To add another client, repeat step 2 and step 3. If this is the last client, click OK to 
close the dialog. 

Specifying the List of Backup Selections 

The Backup Selections list in a database policy has a different meaning than for 
non-database policies. For example, in a Standard policy, the list contains files and 
directories to be backed up. In a database policy, you specify templates or scripts to be 
run. 

For a discussion of NetBackup for DB2 templates and shell scripts, see “Creating 
Templates and Shell Scripts” on page 71. 

Add templates or scripts only if you are setting up a policy for automatic scheduling. All 
templates or scripts listed in the Backup Selections list will be executed for the Automatic 
Full Backup, Automatic Differential Incremental Backup, or Automatic Cumulative 
Incremental Backup schedules, as specified under the Schedules tab, and manual 
backups. NetBackup will start backups according to the order that templates or scripts 
appear in the Backup Selections list. 

The following procedure starts in the Policy dialog. To see the Policy dialog, double-click 
the policy name in the Policies list in the NetBackup Administration Console. 
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▼ To add templates or scripts to the Backup Selections list 

1. In the Policy dialog, click the Backup Selections tab. 

2. Click New. 

3. Enter the name of the selection. 

Templates: 

◆	 Type the name of the template with the .tpl extension. Do not include the full 
path. For example, type weekly_full_backup.tpl. 

OR 

◆ Click the Template button. 

The Select Template dialog is displayed. 

Select the Template from the drop-down list and click OK. 

Templates are stored on the NetBackup master server and do not need to be 
installed on each client. 

Scripts: 

◆ Type the name of the script. 

Be sure to specify the full pathname when listing DB2 scripts. For example: 

/myscripts/db2_backup.sh


Note	 For clustered environments, the scripts must be stored in a location that is available 
after a failover. 

OR 

◆ Click the Remote Folder button. 

The Browse window is displayed. Navigate to the script file and select the file. 
Click OK. 
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Refer to “Creating Templates and Shell Scripts” on page 71 for details on creating 
scripts. 

Be sure that the DB2 scripts listed here are installed on each client in the Client list. 

4. Click OK. 

Configuring a Standard Policy 
In addition to the DB2 policy, you must also configure a Standard type policy. A Standard 
policy will enable the backup of database log files. 

A Standard type policy must be added when: 

◆ userexit for logging is turned on in DB2 UDB. 

◆ Client is a UNIX machine. 

Note	 The name of the policy must be specified in the 
$DB2_Instance_Home/db2.conf file on the client. 

▼ To create a Standard policy 

1. Add a new policy, as specified in “Configuring a NetBackup Policy” on page 31. 

2. Specify the general attributes for the policy: 

a. Select Standard for the policy type. 

b. Specify other attributes as desired. 

3. Add a schedule: 

a. Type the name of your schedule. 

Note	 The name of the policy must be specified in the 
$DB2_Instance_Home/db2.conf file on the client. 

b. In the Type of Backup box, select User Backup. 

This is a user backup that is started by the NetBackup for DB2 user-exit program 
on the client. This schedule specifies the criteria for DB2 archive logs file backups. 
A User Backup schedule enables user controlled NetBackup operations 
performed on the client. 
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c.	 In the Retention box, set the time period needed to retain two full backups of 
your database. 

For example, if your database is backed up once every Sunday morning, select a 
retention period of at least two weeks. 

d.	 In the Start Window section of the Schedules dialog, set the time of day when you 
want backups to occur. 

This schedule must encompass all of the time periods during which DB2 UDB can 
call the user-exit programs. 

Note	 No Backup Selections list is necessary for this policy because it will be a User 
Backup type schedule. 

4.	 Specify the clients that you will be backing up. The client must have: 

◆ DB2 UDB installed 

◆ NetBackup for DB2 installed 

Note If the client is installed in a cluster, add the virtual host name to the policy. 

5. Click OK. 

The Add New Policy dialog box closes. The policy you just configured appears in the 
policy list. 

Specifying the Master Server for a NetBackup for DB2 Client 
After you have added your NetBackup for DB2 client to a policy, you must specify the 
master server for the client in the NetBackup Administration Console. 

▼ To specify the master server in the NetBackup Administration Console 

1. In the left pane, expand Host Properties. 

2. Click Clients. 

3. Double click the NetBackup for DB2 client name in the Clients list. 

4. The Client Properties dialog opens. 

5. In the Properties pane, click Servers. 
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6. Verify that the correct server is displayed in the Master Server field. 

7.	 If not, click the server name in the Additional Servers list, and click Make Master. You 
can also click Add to add a new server name to the list. 

8. Click OK to save your change. 

Do not specify the master server in the Backup, Archive, and Restore interface for the DB2 
client. This can cause backups and restores to fail. To specify the master server for your 
NetBackup for DB2 client, you must set this value in the Client Properties for the DB2 
client on the master server. 
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Configuration Using the NetBackup Administration 
Console for UNIX 

Although the database agent is installed on the NetBackup client, some configuration 
procedures are performed using the NetBackup Administration Console on the server. 

These procedures include: 

◆ Configuring media using Media and Device Management 

◆ Setting the Maximum Jobs per Client property 

◆ Configuring a NetBackup policy 

◆ Testing NetBackup for DB2 configuration settings 

See the next section for instructions on starting the NetBackup Administration Console. 

▼ To launch the NetBackup Administration Console for UNIX 

1. Log onto the UNIX server as root. 

2.	 Start the NetBackup Administration Console by executing: 

install_path/netbackup/bin/jnbSA & 

The login dialog is displayed. 

3.	 Type the name of the master server where you initially want to manage NetBackup. 
You can specify any NetBackup master server. Indicate the User and Password. 
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4. Click Login. The NetBackup Administration Console is displayed. 

Configuring Media Using Media and Device Management 
Use the Media and Device Management (Media Manager) to configure media for a 
NetBackup for DB2 configuration. Refer to the NetBackup Media Manager System 
Administrator’s Guide for more information. 

The number of volumes required will depend on the devices used, the size of the DB2 
databases that you are backing up, and the frequency of backups. 

Setting the Maximum Jobs Per Client Property 
The Maximum jobs per client attribute value is figured with the following formula. 

Maximum Jobs per Client = Number of Sessions x Number of Policies 

Where: 

◆	 Number of Session is the number of backup sessions between the backup server and 
NetBackup on the client. Each separate session starts a new backup job on the client. 
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◆	 Number of Policies is the number of policies that may back up this client at the same 
time. This number can be greater than one. For example, a client may be in two 
policies in order to back up two different databases. These backup windows may 
overlap. 

Tip	 To avoid any problems, we recommend that you enter a high enough value for the 
Maximum jobs per client property to meet the number of jobs executed by DB2. 

▼ To set the Maximum jobs per client property using the NetBackup Administration 
Console for UNIX 

1.	 In the left pane of the NetBackup Administration Console, expand Host Properties. 
Select Master Servers. 

2.	 In the right pane, double-click on the server icon. Click Global Attributes. 

The Master Server Properties dialog is displayed. 

The default value is 1 for Maximum jobs per client. 

3. Change the Maximum jobs per client value to 99. 
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If you prefer to enter a lower value, calculate the value equal to the maximum number 
of backups allowed per client using the formula provided above. 

Configuring a NetBackup Policy 
A NetBackup policy defines the backup criteria for a specific group of one or more clients. 
These criteria include: 

◆ storage unit and media to use 

◆ backup schedules 

◆ clients to be backed up 

◆ script files to be executed on the clients 

To use NetBackup for DB2, at least one DB2 policy with the appropriate schedules needs 
to be defined. A configuration can have a single policy that includes all clients or there can 
be many policies, some of which include only one client. 

Most requirements for DB2 policies are the same as for file system backups. In addition to 
the attributes described here, there are other attributes for a policy to consider. Refer to the 
NetBackup System Administrator’s Guide for Windows, Volume I or NetBackup System 
Administrator’s Guide for UNIX, Volume I for detailed configuration instructions and 
information on all the attributes available. 

DB2 Environments 

In general, the following NetBackup configuration is required to use NetBackup for DB2 
on UNIX: 

◆ To backup the DB2 Database: 

Create a DB2 database policy with an Application Backup schedule. 

◆ To schedule a DB2 Backup using NetBackup: 

Create a DB2 database policy with an Automatic Full, Automatic Differential 
Incremental, or Automatic Cumulative Incremental Backup schedule. 

◆ To backup the DB2 Archive Log files: 

Create a Standard file policy with a User Backup schedule. 

In most DB2 environments, a single DB2 policy can be used. However, in a DB2 EEE 
environment, a minimum of two (2) DB2 policies are needed: one for the DB2 catalog 
node(s), and another for the non-catalog nodes. In any DB2 environment where 
USEREXIT is enabled, a Standard file policy is required. 
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The following sections describe how to create the NetBackup policies and schedules for 
these environments. For DB2 EEE users, see “Configuration for a DB2 EEE (DPF) 
Environment” on page 143. 

Note	 The Media Manager must be configured and a Storage Unit defined before a policy 
can be added. 

Adding New Policies 

Use this procedure when configuring a policy from a UNIX server. 

▼ To add a new policy 

1. Log onto the server as root. 

2. Start the NetBackup Administration Console. 

3.	 If your site has more than one master server, choose the one to which you want to add 
the policy. 

4.	 In the left pane, click on Policies. The right pane splits into an All Policies pane and a 
details pane. 

5.	 In the All Policies pane, right-click on the Master Server, and click New. 

The Add a New Policy dialog is displayed. 

a. In the Policy name box, type a unique name for the new policy. 

b.	 Choose whether to use the wizard for configuring the policy. The wizard guides 
you through most of the setup process and simplifies it by automatically choosing 
default values that are good for most configurations. If necessary, you can change 
the defaults later by editing the policy. You will need to manually add entries to 
the Backup Selections list after completing the wizard. 
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◆	 To use the wizard, select the Use add policy wizard box and click OK. The 
wizard starts and you create the policy by following the prompts. When 
prompted, select the DB2 policy type. 

Note	 The DB2 policy type will not appear in the drop-down list unless your server has a 
license key for NetBackup for DB2. 

◆	 If you require more control over the settings than the wizard provides, do not 
select the Use add policy wizard box and proceed to step 6. 

6.	 Click OK. 

A dialog is displayed in which you can specify the general attributes for the policy. 

7. From the Policy type box, select the DB2 policy type. 
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8.	 Complete the entries on the Attributes tab as explained in “Description of Attributes” 
and click Apply to save the attribute entries. 

9.	 Add other policy information: 

◆ To add schedules, see “Adding New Schedules.” 

◆ To add clients, see “Adding Clients to a Policy.” 

◆ To add templates or shell scripts, see “Specifying the List of Backup Selections.” 

10. Click Apply. The new policy is created. 

Description of Attributes 

With a few exceptions, NetBackup manages a database backup like a file system backup. 
Policy attributes that are different for DB2 backups are explained below. 

Your other policy attributes will vary according to your specific backup strategy and 
system configuration. Consult the NetBackup System Administrator’s Guide for Windows,  
Volume I or NetBackup System Administrator’s Guide for UNIX, Volume I for detailed 
explanations of the policy attributes. 

Description of Policy Attributes 

Attribute Description 

Policy type	 Determines the type of clients that can be in the policy and in some cases 
the types of backups that can be performed on those clients. 
To use NetBackup for DB2, you must have defined at least one DB2 policy. 

Keyword phrase to For NetBackup for DB2, the keyword phrase entry is ignored. 
associate with the 
backup 

Advanced Client	 See the “Using NetBackup for DB2 with Advanced Client” chapter for 
information on configuring policies for snapshot methods. 

Adding New Schedules 

Each policy has its own set of schedules. These schedules control initiation of automatic 
backups and also specify when user operations can be initiated. 

A DB2 backup requires at least two specific schedule types: an Application Backup 
schedule and an Automatic Backup schedule. You can also create additional schedules. 
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The following procedures explain how to configure the required schedule types, and how 
to add other new schedules. The procedures start from the Policy dialog. To see the Policy 
dialog, double click the policy in the policy list in the left pane of the NetBackup 
Administration Console. 

▼ To configure an Application Backup schedule 

1. In the Policy dialog, click the Schedules tab. 

2.	 In the Schedule list, double-click on the schedule named 
Default-Application-Backup. 

A dialog is displayed. The title bar shows the name of the policy to which you are 
adding the schedule. 

All DB2 database operations are performed through NetBackup for DB2 using an 
Application Backup schedule. This includes those backups started automatically. 

You must configure an Application Backup schedule for each DB2 policy you create. If 
you do not do this, you will not be able to perform a  backup. To help satisfy this 
requirement, an Application Backup schedule named Default-Application-Backup is 
automatically created when you configure a new DB2 policy. 

3. Specify the other properties for the schedule as explained in “Schedule Properties.” 

The backup window for an Application Backup schedule must encompass the time 
period during which all NetBackup jobs, scheduled and unscheduled, will occur. This 
is necessary because the Application Backup schedule starts processes that are 
required for all NetBackup for DB2 backups, including those started automatically. 

For example, assume that you: 

◆	 expect users to perform NetBackup operations during business hours, 0800 to 
1300. 

◆ configured automatic backups to start between 1800 and 2200. 

The Application Backup schedule must have a start time of 0800 and a duration of 14 
hours. 
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Tip	 Set the time period for the Application Backup schedule for 24 hours per day, seven 
days per week. This ensures that your NetBackup for DB2 operations are never 
locked out due to the Application Backup schedule. 

Example Settings for an Application Backup schedule	

Type of Backup Schedule settings Description Settings 

Application 
Backup 

Retention The length of time backup images 
are stored. 

2 weeks 

Backup Window The time during which a NetBackup 
operation can be performed. 

Sunday through Saturday 

00:00:01 - 23:59:59 

Note	 The Application Backup schedule name must be specified in the 
$DB2_Instance_Home/db2.conf file on the client. 

▼ To configure an automatic backup schedule 

1. In the Policy dialog, click the Schedules tab. 

2. Click New. 

A dialog is displayed. The title bar shows the name of the policy to which you are 
adding the schedules. 

3. Specify a unique name for the schedule. 

4. Select the Type of Backup. 

For information on the types of backups available for this policy, see “Types of 
Backups.” 

Refer to the following tables for example settings for an Automatic Backup schedule. 

Type of Backup Schedule settings Description Settings 

Automatic Full 
Backup 

Retention The length of time to store the 
record of a backup. 

2 months 

Frequency Frequency determines how often 
a backup should be performed 

every month 

Backup Window The time during which a 
NetBackup operation can be 
performed. 

Sunday, 18:00:00 - 22:00:00 
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Type of Backup Schedule settings Description Settings 

Automatic 
Incremental Backup 

Retention The length of time to store the 
record of a backup. 

1 week 

Frequency Frequency determines how often 
a backup should be performed 

every day 

Backup Window The time during which a 
NetBackup operation can be 
performed. 

Monday through Saturday 

18:00:00 - 22:00:00 

Automatic 
Cumulative 
Incremental Backup 

Retention The length of time to store the 
record of a backup. 

1 month 

Frequency Frequency determines how often 
a backup should be performed 

every week 

Backup Window The time during which a 
NetBackup operation can be 
performed. 

Sunday 

18:00:00 - 22:00:00 

5. Specify the other properties for the schedule as explained in “Schedule Properties.” 

6. If this is the last schedule, click OK. 
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▼ To add other schedules 

1. In the Policy dialog, click the Schedules tab. Click New. 

The Add Schedule dialog is displayed. The title bar shows the name of the policy to 
which you are adding the schedules. 

2. Specify a unique name for the schedule. 

3. Select the Type of Backup. 

For information on the types of backups available for this policy, see “Types of 
Backups.” 

4. Specify the other properties for the schedule as explained in “Schedule Properties.” 

5.	 If this is the last schedule, click OK. To add more schedules, click Add and repeat 
step 2 through step 4. Click Close to cancel changes that you have not yet added and 
close the dialog. 
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Types of Backups 

Caution	 When an automatic schedule is used to invoke a script authored by the user, 
NetBackup cannot provide safeguards preventing unusual behavior, including: 
- a full schedule executing an incremental backup script 
- an incremental schedule executing a full backup script 
- an automatic schedule executing a restore/recovery script 

Whenever possible, using a template instead of a script is recommended, 
because template execution can detect the backup type on the schedule. 
However, the user is still responsible for specifying a template with the correct 
operation type (backup) in the policy. 

Description of Backup Types for DB2 

Application Backup 

Automatic Full 
Backup 

Automatic 
Differential 
Incremental Backup 

Automatic 
Cumulative 
Incremental Backup 

The Application Backup schedule enables user-controlled NetBackup 
operations performed on the client. At least one Application Backup 
schedule type must be configured for each DB2 policy. The 
Default-Application-Backup schedule is automatically configured as an 
Application Backup schedule. 

A full backup copies all blocks into the backup. 

In a differential incremental datafile backup, you back up all blocks that 
have changed since the most recent full or incremental backup. 

In a cumulative incremental backup, you back up all blocks that have 
changed since the most recent full backup. 

Cumulative incremental backups reduce the work needed for a restore by 
ensuring that you only need one cumulative incremental backup at restore 
time. Cumulative backups typically require more space and time than 
Differential Incremental Backups, however, because they contain all 
modifications since the last full backup. 

Schedule Properties 

Some of the schedule properties have a different meaning for database backups than for a 
regular file system backup. These properties are explained in the following table. 
Chapter 3, Configuration 57 



Configuration Using the NetBackup Administration Console for UNIX 
Other schedule properties vary according to your specific backup strategy and system 
configuration. Consult the NetBackup System Administrator’s Guide for Windows, Volume I or 
NetBackup System Administrator’s Guide for UNIX, Volume I for detailed explanations of the 
schedule properties. 

Description of Schedule Properties 

Property Description 

Type of backup	 Specifies the type of backup that this schedule will control. The selection list 
shows only the backup types that apply to the policy you are configuring. 

For more information see the following section “Types of Backups.” 

Frequency	 This setting is used only for scheduled backups, and not for user-directed 
backups. Frequency specifies the period of time that will elapse until the 
next backup operation can begin on this schedule. For example, if the 
frequency is seven days and a successful backup occurs on Wednesday, the 
next full backup will not occur until the following Wednesday. Normally, 
incremental backups will have a shorter frequency than full backups. 

Calendar	 This setting is used only for scheduled backups, and not for user-directed 
backups. The Calendar option allows you to schedule backup operations 
based on specific dates, recurring week days, or recurring days of the 
month. 
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Description of Schedule Properties (Continued) 

Property Description 

Retention Frequency based scheduling 

The retention period for an Application Backup schedule refers to the 
length of time that NetBackup keeps backup images. 

The retention period for an Automatic Full Backup, Automatic Differential 
Incremental Backup, or Automatic Cumulative Incremental Backup 
schedule controls how long NetBackup keeps records of when scheduled 
backups have occurred. 

The NetBackup scheduler compares the latest record to the frequency to 
determine whether a backup is due. This means that if you set the retention 
period to expire the record too early, the scheduled backup frequency will be 
unpredictable. However, if you set the retention period to be longer than 
necessary, the NetBackup catalog will accumulate unnecessary records. 
Therefore, set a retention period that is longer than the frequency setting for the  
schedule.  

For example, if the frequency setting is set to one week, set the retention 
period to be more than one week. 

Calendar based scheduling 

The retention period for an Application Backup schedule refers to the length 
of time that NetBackup keeps backup images. 

The retention period for an Automatic Full Backup, Automatic Differential 
Incremental Backup, or Automatic Cumulative Incremental Backup 
schedule controls how long NetBackup keeps records of when scheduled 
backups have occurred. However, this setting is not significant for calendar 
based scheduling. 

Multiple copies	 If you are licensed for the Inline Tape Copy feature and wish to specify 
multiple copies for your DB2 policy, configure Multiple copies on the 
Application Backup schedule. 

Adding Clients to a Policy 

The client list is the list of clients on which your NetBackup for DB2 backups will be 
performed. A NetBackup client must be in at least one policy but can be in more than one. 

This procedure starts from the Policy dialog. To see the Policy dialog, double-click the 
policy in the policy list in the left pane of the NetBackup Administration Console. 

Requirements for clients 

The following software must be installed on the client: 

◆ DB2 
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◆ NetBackup client or server 

◆ NetBackup for DB2 

◆ the backup or restore script(s) 

▼ To add clients to a policy 

1. In the Policy dialog, click the Clients tab. 

2. On the Clients tab, click New. 

The Add Client dialog is displayed. The title bar shows the name of the policy where 
you are adding clients. 

3.	 In the Client name text box, type the name of the client that you are adding. 

If DB2 is installed in a cluster, specify the virtual DB2 name as the client name. 

4. Choose the Hardware and operating system type and click Add. 

5.	 If this is the last client, click OK. If you are going to add more clients, repeat step 3 and 
step 4. 

Specifying the List of Backup Selections 

The Backup Selections list in a database policy has a different meaning than for 
non-database policies. For example, in a Standard policy, the list contains files and 
directories to be backed up. In a database policy, the list contains templates or script. 

For a discussion of NetBackup for DB2 templates and shell scripts, see “Creating 
Templates and Shell Scripts” on page 71. 

Add templates or scripts only if you are setting up a policy for automatic scheduling. All 
templates or scripts listed in the Backup Selections list will be executed for the Automatic 
Full Backup, Automatic Differential Incremental Backup, or Automatic Cumulative 
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Incremental Backup schedules as specified under the Schedules tab. NetBackup will start 
backups by running the templates or scripts in the order that they appear in the Backup 
Selections list. 

The following procedure starts from the Policy dialog. To see the Policy dialog, 
double-click the policy in the Policies list in the NetBackup Administration Console. 

▼ To add templates or scripts to the Backup Selections List 

1. In the Policy dialog, click the Backup Selections tab. 

2. Click New. 

A dialog is displayed. The title bar shows the name of the policy to which you are 
adding the template or script. 

3. Type the name of the DB2 template or shell script. 

Templates: 

Since templates are stored in a known location on the master server, they do not need 
to be installed on each client in the Clients list. Enter only the template filename, 
without a path. For example: 

weekly_full_backup.tpl


Shell scripts:


Be sure to specify the full pathname when listing DB2 scripts. For example:


/myscripts/db2_backup.sh
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Be sure that the DB2 scripts listed here are installed on each client in the Client list. 

Note	 For clustered environments, the scripts must be stored in a location that is available 
after a failover. 

4. Click Add. 

5. To add more templates or scripts, repeat step 3 and step 4. 

6. When you are finished adding backup selections, click OK. 

Configuring a Standard Policy 
In addition to the DB2 policy, you must also configure a Standard type policy. A Standard 
policy will enable the backup of database log files. 

A Standard type policy must be added when: 

◆ userexit for logging is turned on in DB2 UDB. 

◆ Client is a UNIX machine. 

Note	 The name of the policy must be specified in the 
$DB2_Instance_Home/db2.conf file on the client. 

▼ To create a Standard policy 

1. Add a new policy, as specified in “Configuring a NetBackup Policy” on page 31. 

2. Specify the general attributes for the policy: 

a. Select Standard for the policy type. 

b. Specify other attributes as desired. 

3. Add a schedule: 

a. Type the name of your schedule. 

Note	 The name of the policy must be specified in the 
$DB2_Instance_Home/db2.conf file on the client. 

b. In the Type of Backup box, select User Backup. 
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This is a user backup that is started by the NetBackup for DB2 user-exit program 
on the client. This schedule specifies the criteria for DB2 archive logs file backups. 
A User Backup schedule enables user controlled NetBackup operations 
performed on the client. 

c.	 In the Retention box, set the time period needed to retain two full backups of 
your database. 

For example, if your database is backed up once every Sunday morning, select a 
retention period of at least two weeks. 

d.	 In the Start Window section of the Schedules dialog, set the time of day when you 
want backups to occur. 

This schedule must encompass all of the time periods during which DB2 UDB can 
call the user-exit programs. 

Note	 No Backup Selections list is necessary for this policy because it will be a User 
Backup type schedule. 

4.	 Specify the clients that you will be backing up. The client must have: 

◆ DB2 UDB installed 

◆ NetBackup for DB2 installed 

Note If the client is installed in a cluster, add the virtual host name to the policy. 

5. Click OK. 

The Add New Policy dialog box closes. The policy you just configured appears in the 
policy list. 

Specifying the Master Server for a NetBackup for DB2 Client 
After you have added your NetBackup for DB2 client to a policy, you must specify the 
master server for the client in the NetBackup Administration Console. 

▼ To specify the master server in the NetBackup Administration Console 

1. In the left pane, expand Host Properties. 

2. Click Clients. 

3. Double click the NetBackup for DB2 client name in the Clients list. 
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4. The Client Properties dialog opens. 

5. In the Properties pane, click Servers. 

6. Verify that the correct server is displayed in the Master Server field. 

7.	 If not, click the server name in the Additional Servers list, and click Make Master. You 
can also click Add to add a new server name to the list. 

8. Click OK to save your change. 

Do not specify the master server in the Backup, Archive, and Restore interface for the DB2 
client. This can cause backups and restores to fail. To specify the master server for your 
NetBackup for DB2 client, you must set this value in the Client Properties for the DB2 
client on the master server. 
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Configuring the Run-Time Environment 

Environment Variables 
It is important to note that these environmental variables are created by the NetBackup 
automatic scheduler when it executes a script. 

Note	 The environmental variables below are only used in the executing script. They are 
unknown to the DB2 UDB backup/restore. For example, the DB2_POLICY variable 
will not be processed by the DB2 UDB backup or DB2 UDB restore. Instead it uses 
the POLICY name defined in the $DB2_Instance_Home/db2.conf file. 

When the NetBackup automatic scheduler calls a DB2 template or script, the following 
environmental variables are created. 

DB2_POLICY	 Name of the NetBackup for DB2 policy from which the Automatic 
Backup backup type was started. This policy name is not 
necessarily the same policy name that is in the db2.conf file. This 
variable is set only if the backup is initiated from the server 
(either automatically by the NetBackup scheduler or manually 
through the administrator interface). 

DB2_SERVER Name of the NetBackup server. 
DB2_SCHED	 Name of the NetBackup schedule. This variable is set up only if the 

backup is initiated from the server (either automatically by the 
NetBackup scheduler or manually through the administrator 
interface). 

DB2_SCHEDULED Set to 1 if this is a scheduled backup type (Automatic Backup). 
DB2_USER_INITIATED	 Set to 1 if this is a user-initiated backup type (Application Backup  

backup). 
Note The variables below can be tested within the script to determine which type of backup has 

been requested. 
DB2_FULL Set to 1 for an Automatic Full Backup. 
DB2_INCR Set to 1 for an Automatic Differential Incremental Backup 
DB2_CINC Set to 1 for an Automatic Cumulative Incremental Backup. 

Creating a db2.conf File 
A db2.conf file is a control file that indicates what policy, schedule, and database to use. 
You must place this file in the $DB2_Instance_Home/ directory on all the NetBackup for 
DB2 clients. A sample copy is provided in the sample directory. 
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Example 

Assume we are backing up a database named SAMPLE and its archive logs. We have 
already configured two policies that have the required schedules for our backups. 

One of the policies is for backing up the database. This policy is named DB2_DB_Policy  
and has both an Application Backup schedule and an Automatic Backup schedule. The 
first entry in the example file below specifies this policy and its Application Backup 
schedule, which is named Default-Application-Backup. The Automatic Backup schedule is 
not specified in db2.conf. 

The other policy is for backing up the archive logs. This policy is named DB2_Log_Policy 
and has a User Backup type schedule named User. The second entry in the example file 
below specifies this policy and its User Backup schedule. 

#

# The following settings are used by NetBackup to backup/restore a DB2 database.

#

# Reminders:

# 1) The specified policy must have a type of "DB2".

# 2) The specified schedule must be defined for this policy.

# 3) The DB2 database host must be entered as a client for this policy.

#


OBJECTTYPE DATABASE

DATABASE SAMPLE

POLICY DB2_DB_Policy

SCHEDULE Default-Application-Backup

ENDOPER


#

# The following settings are used by NetBackup to backup/restore DB2 log files.

#

# Reminders:

# 1) The specified policy must have a type of "Standard" (for UNIX DB2 host) or

# "MS-Windows-NT" (for Windows DB2 host).

# 2) The specified schedule must be defined for this policy.

# 3) The DB2 database host must be entered as a client for this policy.

#

# If DB2 log file archiving is enabled (DB2 USEREXIT ON), DB2 will invoke

# the NetBackup user-exit program to backup & restore DB2 archive log files.

# Using ARCFUNC SAVE causes log files to be archived to NetBackup storage,

# as specified by the policy.

# Using ARCFUNC COPY causes log files to be archived to a disk directory.

# Use ARCDIR to specify the destination directory for log file backup.

# Use RETDIR to specify the source directory for log file restore.

#


OBJECTTYPE ARCHIVE

DATABASE SAMPLE

POLICY DB2_Log_Policy

SCHEDULE User

ARCFUNC SAVE
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#ARCFUNC COPY

#ARCDIR /home/db2inst1/arcdir

#RETDIR /home/db2inst1/arcdir

ENDOPER


Using ARCFUNC to Back up Archive Logs 

ARCFUNC can be used with two options: SAVE and COPY. The default option is SAVE. 

When using ARCFUNC SAVE, the name of the Standard policy configured earlier (see 
“Configuring a Standard Policy” on page 43) must be recorded in the db2.conf file. 

The following is an example of a db2.conf file for backing up archive log files for the 
database SAMPLE using ARCFUNC SAVE. The policy name is db2_archive and the 
schedule name is db2_archive_sched 

DATABASE SAMPLE

OBJECTTYPE ARCHIVE

POLICY db2_archive

SCHEDULE db2_archive_sched

ARCFUNC SAVE

ENDOPER


The ARCFUNC COPY function is different. It copies the archive log(s) to the ARCDIR. 
There is no NetBackup policy or schedule involved or needed. The user exit program 
(db2uext2) does the copy operation when called by DB2. However, you must setup 
ARCDIR and the RETDIR in the db2.conf file for the operation to function properly. 
The following example shows contents of a db2.conf file for the database SAMPLE. 

DATABASE SAMPLE

OBJECTTYPE ARCHIVE

ARCFUNC COPY

ARCDIR /mylogs/arcdir/

RETDIR /mylogs/arcdir/

ENDOPER


At some point, the disk will become full with archived log files.  To manage this, you need 
to configure a separate Standard policy to archive the entire ARCDIR directory to 
NetBackup storage. To reclaim the disk space, the policy must use a "User Archive" 
schedule type. This instructs NetBackup to delete the files after they have been 
successfully backed up. Refer to the NetBackup System Adminstrator's Guide for more 
information about User Archive schedules. 

Note	 This policy is managed by NetBackup only and has nothing to do with the 
db2.conf file. 
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Using ARCFUNC During Restore of Archive Log Files 

If your database is restored to a rollforward pending state, execute a ROLLFORWARD 
DATABASE command. DB2 will request the archive log files it needs to do the rollforward. 
DB2 will perform the rollforward through the user exit program. 

When a restore request comes in from DB2 and the ARCFUNC option is SAVE, the user 
exit program will look for the file from tape or other device you setup for backup. When 
using this option, you will not need to worry about the ARCDIR or RETDIR options. 

When the option for ARCFUNC is COPY, the user exit program will look for the file to 
restore from the RETDIR you specified in the db2.conf file. If some or all of the files 
have been archived to NetBackup storage, you must restore them to the RETDIR directory 
before performing a ROLLFORWARD DATABASE command. See the "Performing Restores" 
section in the NetBackup User's Guide for detailed instructions regarding how to restore a 
file to disk. The ROLLFORWARD DATABASE command will request the log files that DB2 
needs from the user exit program. The user exit program will look in the RETDIR to find 
the file since the option for ARCFUNC is COPY. The user exit program will then copy the 
files to the DB2 primary log directory. 

Important Points 

Remember the following about the db2.conf file. 

◆ A different POLICY name needs to be specified for DATABASE and ARCHIVE objects. 

◆	 A db2.conf consists of a series of entries that define the policy and schedule based 
upon the OBJECTTYPE. 

◆ OBJECTTYPE and POLICY are required fields and all other fields are optional. 

◆	 Each operation consists of a series of keyword, value pairs, which completely define the 
total action. 

◆ The keyword is not case sensitive, but the value is. 

◆ Entries are not nested. 

◆	 Within an entry, the keyword, value pairs can appear in any order. Each entry must be 
terminated by ENDOPER. 

◆ Any line with a # in the first column is treated as a comment line. 
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Keywords


The following table describes the keywords and values used in db2.conf file. 


Keyword Value Required Default Description 

ARCDIR directory path yes, if the value for 
ARCFUNC is COPY 

no, if the value for 
ARCFUNC is SAVE 

none directory path name where 
archive logs are moved to. 

ARCFUNC SAVE|COPY no SAVE Only for OBJECTTYPE is 
ARCHIVE. SAVE saves a 
backup/restore archive log 
to/from NetBackup. COPY 
copies an archive to/from 
ARCDIR/RETDIR directories. 

POLICY NB policyname yes none NetBackup policy name. 

DATABASE database_name no none DB2 database name. 

If OBJECTTYPE is ARCHIVE, 
then a Standard policy must be 
specified. 

If OBJECTTYPE is DATABASE 
or TABLESPACE, then a DB2 
policy must be specified. 

ENDOPER none yes none Terminates each entry. 

OBJECTTYPE DATABASE 
TABLESPACE 
ARCHIVE 

yes none Type of backup/restore being 
performed. 

DATABASE and TABLESPACE 
are for DB2 policy types. 
ARCHIVE is for the Standard 
policy type. 

RETDIR directory path yes if the value for 
ARCFUNC is COPY 

no if the value for 
ARCFUNC is SAVE 

none The directory path name 
where archive logs are 
retrieved from. 

SCHEDULE nb schedname no first Application 
Backup in policy 

NetBackup schedule name in 
policy. 
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Configuring the bp.conf File for a Cluster Environment 
When using DB2 in a cluster environment, you must create a bp.conf file in the home 
directory of the DB2 instance owner. In this file, set the CLIENT_NAME entry to the 
virtual name of the DB2 instance. 

In the bp.conf file located in the usr/openv/netbackup directory, set the 
CLIENT_NAME entry to the actual host name of the NetBackup for DB2 client. This will 
allow other backups to be performed on the host. 
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Creating Templates and Shell Scripts 
To perform a scheduled NetBackup for DB2 backup, you must create a template or shell 
script. The template or shell script will direct the backup job on the NetBackup for DB2 
client. You will add this template or shell script to the Backup selections list in the 
NetBackup for DB2 policy on the master server. You can also use the template or shell 
script to manually start a backup on the client. 

Understanding Templates and Shell Scripts 

Templates 

The NetBackup for DB2 Backup Wizard is used to create backup templates. This wizard is 
initiated from the NetBackup Backup, Archive, and Restore interface. See “Creating a 
Backup Template Using the NetBackup for DB2 Backup Wizard” on page 72. 

The NetBackup for DB2 Backup Wizard does not support all of the commands and 
options provided by DB2. A script should be written for situations where a template does 
not provide all of the required functionality. 

Shell Scripts 

Shell scripts are written by the user and must conform to DB2 and UNIX shell syntax. 
Sample backup and recovery shell scripts are installed on the client with the NetBackup 
for DB2 agent. Modify these scripts to meet your individual requirements. See “Creating 
DB2 Scripts Manually” on page 77 for more information on sample scripts. 

NetBackup for DB2 also provides a utility, bpdbsbdb2, that can generate a shell script 
from a Backup Wizard template. This allows a user to create a template with the Wizard, 
then generate a shell script from it. The user can then run the shell script, or modify the 
shell script further. See “Creating Shell Scripts Using bpdbsbdb2” on page 76. 

Specifying the NetBackup Master Server from the Client 
To ensure that the templates you create are saved to and run from the correct master 
server, specify the master server from the client. 
Chapter 3, Configuration 71 



Creating Templates and Shell Scripts 
Setting the Master Server in Backup, Archive, and Restore 

Use the Backup, Archive, and Restore GUI to specify the NetBackup master server from 
the client. Setting the master server in the client GUI ensures that the templates you create 
will be saved to the same master server where you created the NetBackup for DB2 
policies. 

▼ To specify the master server 

1.	 In the Backup, Archive and Restore, click Actions > Specify NetBackup Machines 
and Policy Type. 

2. In the dialog, click the NetBackup server tab. 

3.	 If the master server is not in the Server List, enter the server name in the New Server 
Name field. Click Add. 

4. Select the master server in the Server List, and click Make Current. 

5. Click OK. 

Setting the Master Server in the User bp.conf 

To ensure that the templates you create are run from the master server where you created 
the NetBackup for DB2 policies, specify the master server in the user bp.conf file in one of 
the following locations: 

$DB2_HOME/bp.conf


or 

$NBU_HOME/bp.conf


Creating a Backup Template Using the NetBackup for DB2 
Backup Wizard 

Create the backup template using the NetBackup for DB2 Backup Wizard, available in the 
NetBackup Backup, Archive, and Restore interface. 
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Browsing for the DB2 Instance to Back Up 

You can browse the DB2 environment in the Backup, Archive, and Restore interface on the 
NetBackup for DB2 client. 

❖ To start the NetBackup Backup, Archive, and Restore interface, execute: 

install_path/netbackup/bin/jbpSA & 

If DB2 is installed, the Backup, Archive, and Restore interface for your DB2 client displays 
a DB2 resource node in the left pane. Click the Backup Files tab, and expand the DB2 
resource in the left pane to view a DB2 instance hierarchy. Select a node in the left pane to 
view details in the right pane. 

Selecting any parent database object automatically selects all the children objects beneath 
it. The following table provides an explanation of the DB2 object types displayed. 

DB2 Database Objects in the Backup Window 

DB2 resource	 If NetBackup for DB2 is detected on the client, the browser 
window displays the DB2 resource. This is the top level DB2 object 
in the browser. 
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DB2 Database Objects in the Backup Window 

instance	 The second level object is a DB2 instance. An instance represents a 
collection of DB2 databases. 

database	 While you cannot directly select a whole database for backup, you 
can select a database for backup by selecting all partitions that 
belong to it. If you select the database for backup in this way, you 
will not be able to select other databases. If you select objects 
within the database, you will not be able to select objects within 
other databases at the same time. 

partition	 The partition represents a collection of storage with a database. 
Partitions contain table spaces and log folders. Within a database, 
you can select a partition or more than one partition. 

DB2 EEE/DPF environments generally consist of multiple 
partitions. Other DB2 UDB environments consist of a single 
partition, which is usually represented as partition zero (0). 

Note Only partitions that reside on the same NetBackup client are 
displayed. Other partitions on remote hosts are not displayed. See 
the Caution below for more information. 

table space	 A table space is a logical entity representing a collection of physical 
storage containers. Table spaces are comprised of containers, 
which represent database storage units. A table space is the lowest 
level DB2 object you can select in the browser. 

Caution	 Because the GUI only displays local or resident partitions, templates created on 
the local client will not back up partitions on remote hosts. You must create 
additional templates for the other remote partitions by running the wizard on 
those clients. To back up the entire EEE/DPF configuration, specify multiple 
templates in the policy Backup Selections list. 

Using the NetBackup for DB2 Backup Wizard 

When you have selected the DB2 database, partition(s), or table space(s) that you want to 
back up, you can use the NetBackup for DB2 Backup Wizard to create a backup template 
for that DB2 element. The following procedure takes place in the Backup, Archive, and 
Restore interface on the NetBackup for DB2 client. 
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▼ To create a backup template using the NetBackup for DB2 Backup Wizard 

1.	 In the Backup, Archive and Restore interface, select the DB2 object(s) you want to 
back up. 

2. Click Backup. 

The NetBackup for DB2 Backup Wizard displays several screens where you will enter 
information about the backup operation you want to perform: 

◆ Welcome 

◆ Database Login 

◆ Initial Settings 

◆ Backup Options 

◆ Template Summary 

If you need an explanation of any of the fields on the wizard panels, or more details, 
click Help on the wizard panel. 

3.	 When you have completed the wizard, the Template Complete screen displays. You 
can choose to save the template for later use, run the template immediately, or both. 

Click Help for details about saving and running the template you created. 

When you are satisfied with the template, click Finish to save, run, or save and run the 
template you created. 

When a backup template is run from the wizard, a full backup is performed. 
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Creating Shell Scripts Using bpdbsbdb2 
bpdbsbdb2 is a NetBackup for DB2 command line utility used to initiate template based 
user-directed backup and recovery. This utility is also used to generate DB2 shell scripts 
from templates created by the Backup Wizard. 

At the command prompt, type: 

bpdbsbdb2 -backup -g <script file name> -t <template name>


The following options are supported: 

-g script file name	 Generates a shell script from a template. Enclose script file name in 
quotes if it contains blanks. This option may not be used with the run 
option. See “Using bpdbsbdb2” on page 100. 

-t template name Identifies the template. 

bpdbsbdb2 will retrieve backup templates from a known location on 
the master server. Therefore, specify only the file name. 

Caution	 It is the user's responsibility to review and customize any/all scripts generated 
from templates. Generated scripts are intended to be modified for the user's 
environment and preferences. For example, settings such as passwords or 
catalog partition numbers are not generated in the template to script 
conversion, and require manual intervention. In addition, generated scripts do 
not handle all possible error and failure cases, and should be used at your own  
risk. 

Scripts generated for UNIX are intended to be executed by an authorized DB2 user or by 
root. 

Script execution permissions should be reviewed and modified as desired by the user. 

For security purposes, usernames and passwords are not included in generated scripts, 
and must be added if needed. 

The DB2 QUIESCE command is generated when the Disconnect users and prohibit 
access template option is specified. However, this command will fail if your version is 
prior to DB2 V8.1. 

When attempting a point-in-time restore, the time value must be customized. The 
command DB2 RESTORE ... TAKEN AT strictly interprets the specified time, and will 
succeed only if a backup image with the same time exists. See the DB2 Command 
Reference for details. (This limitation does not exist for templates, which search for an 
appropriate image.) 
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If a template enables roll-forward recovery, then roll-forward commands are generated for 
all partitions specified in the template, whether or not that partition is configured for 
roll-forward recovery. 

If a script performs a roll-forward recovery, the DB2NODE variable must be customized. In 
single partition environments, this variable can typically be empty, for example, 
“DB2NODE=”. In a multiple partition environment, this variable must be set to the catalog 
partition number. 

Creating DB2 Scripts Manually 

Note For more information on scripts, see the DB2 Commands User’s Guide. 

The following example scripts were included with the NetBackup for DB2 installation: 

db2_backup 

db2_restore 

db2_all_backup_mpp 

db2_all_restore_mpp 

These scripts were provided as examples. They are installed in the following directory: 

install_path/netbackup/ext/db_ext/db2/scripts


where install_path is /usr/openv by default. 

Note	 Be sure to modify these scripts for your environment. Do not store your scripts in 
the sample directory, as they will be lost when upgrading or re-installing. Always 
relocate your scripts to a safe location. For clustered environments, this location 
must be available after a failover. 

Although each script can have multiple DB2 commands operations, a separate script is 
required for each type of operation. For example, you need separate scripts for backups 
and restores. 

Caution	 Always specify the correct script when configuring automatic backups or when 
starting operations through NetBackup. NetBackup for DB2 will not generate 
an error if a restore script is used for a backup operation or a backup script is 
used for a restore operation. 
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Instructions for Modifying Scripts 

Note	 If you do not include an su - user (user is the DB2 instance account) in your scripts, 
they will not run with the proper permissions and environmental variables. 

Note	 If you are using DB2 EEE, see “Creating DB2 Templates or Scripts for a DB2 EEE 
Environment” on page 148. 

1.	 Copy the example scripts to a different directory on your client. This should be a safe 
location. In clustered environments, this location should be available after a failover. 

2.	 Set the access permissions of these scripts to 775. 

chmod 775 script_name 

3. Modify the script 

a. Use a text editor such as vi to open the script. 

b. Follow the instructions in the script. 

Note	 Test the scripts you just created by starting a manual backup of this policy as 
explained in “Testing NetBackup for DB2 Configuration Settings” on page 80. 

Script Parameters 

Parameters are necessary in DB2 template or scripts to enable the DB2 commands to 
perform backup and restore operations. The parameters can come from one of these 
sources: 

◆ Environmental Variables 

◆ NetBackup bp.conf 

◆ NetBackup db2.conf 

Parameters from these sources can be evaluated within the scripts.  For example, the 
DB2_POLICY value is the name of the policy used to perform the backup. 

For details, please see “Configuring the Run-Time Environment” on page 65. 
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Storing Templates and Scripts 

Templates 

The NetBackup for DB2 Backup Wizard saves a backup template to a NetBackup specific 
location on the current NetBackup master server. A backup template is retrieved from the 
master server as part of a backup (server-directed, scheduled, or user-directed) and is run 
on the client. A backup template is associated with a policy by specifying its name in the 
policy file or script list. Because backup templates are stored on the server in a known 
location, server directed and scheduled backups will use the same copy of the template 
for each client in the policy client list. 

The NetBackup for DB2 Recovery Wizard saves a restore template to a user specified 
location on the client. The location specified should include a fully qualified path to a 
directory where the user has write access. For information about the recovery wizard, see 
“Using the NetBackup for DB2 Recovery Wizard” on page 96. 

Templates store encrypted passwords that are decrypted at runtime. 

Shell Scripts 

DB2 scripts must reside on the NetBackup client. Backup scripts are associated with a 
policy by specifying the file name (including path) in the policy file or script list. This 
means that for server-directed or scheduled backups, each client in the policy's client list 
must have a copy of the script with the same name in the same location. See “Specifying 
the List of Backup Selections” on page 41. 

The backup and recovery processes sometimes require passwords for DB2 database access 
and/or system user accounts. 
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Testing NetBackup for DB2 Configuration Settings 
After configuring the master server for NetBackup for DB2, test the configuration settings. 
For a description of status codes, refer to the NetBackup Troubleshooting Guide for UNIX and 
Windows. 

NetBackup Administration Console for Windows 
Use this procedure to test a policy configuration from a Windows server or from the 
Remote Administration Console. 

▼ To test the configuration settings on a Windows server 

1. Log onto the server as administrator. 

2. Start the NetBackup Administration Console. 

3. In the left pane, click Policies. The policy list appears in the right pane. 

4. Click on the policy you wish to test. 

5.	 Choose Actions > Manual Backup. 

The Manual Backup dialog is displayed. 

The Schedules pane contains the name of a schedule (or schedules) configured for the 
policy you are going to test. The Clients pane contains the name of the client(s) listed 
in the policy you are going to test. 

6. Follow the instructions on the dialog. 
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7. Click Activity Monitor on the NetBackup Administration Console. 

If the manual backup does not exit with a successful status, refer to the 
Troubleshooting chapter. 

NetBackup Administration Console for UNIX 
Use this procedure to test a policy configuration on the NetBackup Administration 
Console for UNIX. 

▼ To test the configuration settings on a UNIX server 

1. Log onto the server as root. 

2. Start the NetBackup Administration Console. 

3.	 In the left pane, click Policies. 

The right pane splits into an All Policies pane and a details pane. 

4. In the All Policies pane, click the policy you wish to test. 

5. Choose Actions > Manual Backup. 
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The Manual Backup dialog is displayed. 

The Schedules pane contains the name of a schedule (or schedules) configured for the 
policy you are going to test. The Clients pane contains the name of the client(s) listed 
in the policy you are going to test. 

6. Follow the instructions on the dialog. 

7. Click Activity Monitor on the NetBackup Administration Console. 
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If the manual backup does not exit with a successful status, refer to the 
Troubleshooting chapter. 
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4


When all installation and configuration is complete, you can start DB2 backups and 
restores through NetBackup or execute DB2 UDB commands directly. 

This chapter contains the following sections: 

◆ Performing a Backup 

◆ Browsing Back Ups 

◆ Performing a Restore 

Caution	 Always specify the correct DB2 script or template when configuring automatic 
backups or when starting operations through NetBackup (see the Configuration 
chapter). NetBackup for DB2 will not generate an error if a restore DB2 script 
file is used for a backup operation or a backup DB2 template or script is used for 
a restore operation. 
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Performing a Backup 
There are two types of DB2 backups: database and archive logs. 

◆	 A database backup is a copy of the entire database or tablespaces. This backup is 
accomplished by executing a DB2 BACKUP DATABASE command. A database backup 
can be initiated through NetBackup by an automatic backup of a DB2 policy, a manual 
backup of a DB2 policy, or a user-directed backup. 

◆	 An archive log backup is a backup of an archive log file for DB2. These backups are 
initiated by DB2 through a user exit program. 

Performing a Backup from the NetBackup Master Server 

Automatic Backup of a DB2 Policy 

The most convenient way to back up your database is to set up schedules for automatic 
backups. When the NetBackup scheduler invokes a schedule for an automatic backup, the 
DB2 scripts run: 

◆ In the same order as they appear in the file list 

◆ On all clients listed in the client list 

The DB2 scripts will start the database backup. 

To add a new schedule or change an existing schedule for automatic backups, follow the 
guidelines given in the Configuration chapter. 

When a backup template is run from a NetBackup schedule, the schedule determines the 
backup type (full, cumulative, or differential). 

If an online backup of a partition is requested, the DB2 LOGRETAIN or USEREXIT setting 
must be enabled. If not, an offline partition backup will be attempted. An offline backup is 
also attempted if the database is in backup-pending mode. 

If a table space backup is requested, the DB2 LOGRETAIN or USEREXIT setting must be 
enabled. If not, DB2 does not support offline tablespace backup, so template execution 
will fail. 

For more information about templates, see “Running a NetBackup for DB2 Backup 
Template” on page 87. 
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Manual Backup of a DB2 Policy 

The administrator on the master server can use the NetBackup administrator’s interface to 
manually execute an Automatic Backup schedule for a DB2 policy. The instructions for 
doing this are the same as given in “Testing NetBackup for DB2 Configuration Settings” 
on page 80. 

Refer to “Testing NetBackup for DB2 Configuration Settings” on page 80 for instructions 
on initiating a backup of a DB2 policy. 

Performing a User-Directed Backup from the NetBackup for 
DB2 Client 

Running a NetBackup for DB2 Backup Template 

When executing a template, database partitions are processed sequentially, in the order 
listed in the template summary. All table spaces residing with the same partition are 
processed together. For example, if table space T1 resides in partition P1, and table spaces 
T2 and T3 reside in partition P2, the processing order is: 

1. Process table space T1 in partition P1. 

2. Process table spaces T2 and T3 in partition P2. 

A failure in processing a request immediately stops the template execution. The error 
condition must be resolved before the template can be re-executed. 

Except where noted, all DB2 warnings are treated as DB2 errors; they cause template 
execution to fail. 

If the Disconnect users and prohibit access template option is selected, the DB2 QUIESCE 
command is attempted before performing the backup or restore. In versions prior to DB2 
V8.1, this feature is not available and instead the Abort if users are connected option is 
enforced . 

Users must have sufficient DB2 permissions to browse DB2 databases and perform 
backup, restore, and rollforward operations. Refer to the following DB2 database manager 
configuration settings: SYSADM, SYSCTRL, and SYSMAINT. 

Using DB2 Template Administration 

The DB2 Template Administration dialog is available in the NetBackup Backup, Archive, 
and Restore interface. 
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Use this dialog to run, edit, delete, rename, and view existing backup templates. These are 
the templates created by the NetBackup for DB2 Template Generation Wizard and stored 
in a pre-determined location on the master server. See “Creating a Backup Template Using 
the NetBackup for DB2 Backup Wizard” on page 72. 

▼ To use DB2 Template Administration 

1.	 In the Backup, Archive, and Restore interface, choose Actions > Administer 
Templates > DB2. 

The DB2 Template Administration window appears: 

The Select Template list shows the names and descriptions of the DB2 backup 
templates stored on the current master server. 

2. Select the name of the backup template you wish to run. 

3.	 Click Run. 

The Run dialog displays: 

4. Supply a User name and Password. Click OK. 
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A Template Summary window displays: 

5.	 Click Run. The template will run a full backup. Incremental backups are only 
available through the NetBackup scheduler. 

You can use the View Status tool to see the status of the backup. Click File > View 
Status. 

The DB2 Template Administration window provides the following functions: 

Run Run executes the selected template. 

Edit	 Edit is used to change the contents of an existing template. The 
selected template is loaded into the NetBackup for DB2 Template 
Generation Wizard. 

Delete	 Delete is used to delete the selected template. 
You must be the root user or the template creator to delete a 
template. 

Rename	 Rename is used to change the name of the selected template. 
You must be the root user or the template creator to rename a 
template. 

View View is used to see a summary of the selected template. 
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Using bpdbsbdb2 

The bpdbsbdb2 command allows you to run a backup template created by the 
NetBackup for DB2 Backup Wizard. 

At the command prompt, type: 

bpdbsbdb2 -backup -r -t <template name>


where -r runs a template and -t identifies the template. 

For example: 

bpdbsbdb2 -backup -r -t DB2_Mon_full.tpl


bpdbsbdb2 will retrieve backup templates from a pre-determined location on the master 
server. Therefore, specify only the file name. 

Using DB2 to Perform a Backup 

You can start a backup by executing the DB2 BACKUP DATABASE command from the 
command line on the client. For example: 

For a Solaris or Linux client you would enter: 

db2 backup database sample load /install_path/netbackup/bin/nbdb2.so


For an AIX or HP-UX client you would enter:


db2 backup database sample load /install_path/netbackup/bin/nbdb2.sl


Note that for a 64-bit DB2 instance, specify the pathname for the 64-bit library as follows. 

For Solaris: nbdb2.so64 

For AIX or HP-UX: nbdb2.sl64 

Refer to the IBM DB2 Universal Database Command Reference for details on using the DB2 
BACKUP DATABASE command. 

Using xbp to Perform a Backup 

Note xbp is not supported on AIX platforms. 

The following describes how to use xbp to back up your database. Refer to the xbp man 
page and the online help in the interface for detailed instructions on using xbp to back up 
the database. 
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▼ To perform a backup using xbp 

1. Log in as the DB2 administrator or as root. 

If you are already logged in under a different user account, use the su - command to 
change to the DB2 administrator. 

2.	 Execute xbp on the client to which you want to backup a database. 

install_path/netbackup/bin/xbp 

3.	 In the Directory to Search Box, type the path name of the location of the DB2 scripts. 
For example: 

install_path/netbackup/ext/db_ext/db2/scripts/


4. Choose File > Browse File System for Backup Scripts. 

5. Select the backup script from the Files pane. 

6.	 Choose Backup > Backup Database Using Selected Scripts. The xbp_confirm dialog 
displays. 

7.	 Click OK. 

A NetBackup process called bphdb starts the DB2 script on the client. 

8. View the status of the script execution. 

a.	 Choose Backup > Report Progress Of Backup.... 

The xbp_progress dialog displays. 

b. Select the log file for your backup. 

The Contents of Selected Log File pane displays only the status of the script 
execution. A status =0 message indicates that the script was successfully 
completed. Go to Step 9 for a detailed status report. For a status other than 0, refer 
to the Troubleshooting section of this manual. For additional information, check 
the output of the script. 

9. View the log file for the NetBackup operation. 

a.	 Change directories to the bphdb log directory. 

cd install_path/netbackup/logs/bphdb 

b. Open the log file with the tail option. 
Chapter 4, Using NetBackup for DB2 91 



Browsing Back Ups 
tail -f log.mmddyy


A Backup completed SUCCESSFULLY message indicates a successfully completed 
NetBackup operation. 

Browsing Back Ups 
This section describes how to browse backup images. You can also use the DB2 LIST 
HISTORY command. For instructions on using this command, see the IBM DB2 Universal 
Database Command Reference manual. 

Using Backup, Archive, and Restore to Browse 
The Backup, Archive, and Restore interface displays the DB2 resource. You can browse the 
DB2 resource through four levels: instance, database, partition, and tablespace. You can 
view the containers in a tablespace, but you can only select for restore at the tablespace 
level or the partition level. 

This interface does not currently allow browsing of previous backups. Instead, it browses 
the existing DB2 instances and databases. You can select these DB2 objects and use the 
NetBackup for DB2 Recovery Wizard to prepare recovery templates for the objects. See 
“Using the NetBackup for DB2 Recovery Wizard” on page 96. See “Using the NetBackup 
for DB2 Recovery Wizard” on page 85. 
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The following shows a sample restore window in the Backup, Archive, and Restore 
interface. In this example, the DB2 resource is expanded down to the table space level. You 
can select a tablespace or table spaces, a partition or partitions, or one entire database (by 
selecting all of its partitions) for the restore. 

Using bplist to Browse 
The following example uses bplist to search all DB2 backups (images) for the client 
named camel, which is also the master server. The information comes from the NetBackup 
catalog on the master server. The -t 18 on this command specifies DB2 backup types. 
The bplist output shows the list of DB2 database backup images that are stored in the 
NetBackup database. See the NetBackup online help for more information on the bplist 
command. 

install_path/netbackup/bin/bplist -C camel -S camel -t 18 -R / 
/DB2/SAMPLE/node0000/19991202105152/SAMPLE.0.DB2.node0000.0.19991202105152.1 
/DB2/SAMPLE/node0000/19991202104734/SAMPLE.0.DB2.node0000.0.19991202104734.1 
/DB2/SAMPLE/node0000/19991201171209/SAMPLE.0.DB2.node0000.0.19991201171209.1 
/DB2/SAMPLE/node0000/19991129154117/SAMPLE.3.DB2.node0000.4.19991129154117.1 
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/DB2/SAMPLE/node0000/19991129142046/SAMPLE.0.DB2.node0000.0.19991129142046.1


The next example uses bplist to search for all DB2 archive log file backups. The -k 
DB2_Log_Policy specifies files backed up using this policy. The policy name originates 
from the settings in the db2.conf file for archive log files. The bplist output shows the 
list of DB2 archive log files stored in NetBackup. 

install_path/NetBackup/bin/bplist -k DB2_Log_Policy -C camel -S camel -R / 
/home/db2inst/NODE0000/SQL00001/SQLOGDIR/S0000026.LOG 
/home/db2inst/NODE0000/SQL00001/SQLOGDIR/S0000025.LOG 
/home/db2inst/NODE0000/SQL00001/SQLOGDIR/S0000024.LOG 

The following diagram explains how to interpret one of the lines from the listing. 
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Using xbp to Browse 

Note xbp is not supported on AIX platforms. 

The following describes how to use xbp to browse your database backups. Refer to the 
xbp man page and the online help in the interface for detailed instructions on using xbp to 
browse database backups. 

1. Log in as the DB2 administrator or as root. 

If a different user account is used, use the su command to change to the DB2 
administrator. 

2.	 Execute xbp on the client. 

install_path/netbackup/bin/xbp 

The xbp dialog is displayed. 

3.	 From the File menu, click Configuration. 

The xbp_config dialog displays. 

a. In the Policy type of image to browse, specify the DB2 policy. 

b. Click OK to close the dialog. 

c. In the Directory To Search Box, enter / as the directory to search. 

d. Set the Range of Dates to include the date of your backup. 

e. Enter 9 in the Directory Depth Box. 

f.	 From the File menu, select Browse Backups (Restore). A list of backup images 
appears in the dialog. 
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Performing a Restore 

Executing the NetBackup for DB2 Template on the Client 

Using the NetBackup for DB2 Recovery Wizard 

NetBackup for DB2 includes a Recovery Wizard that solicits information from the user 
about the desired DB2 restore and recover operations. The wizard uses the information to 
create a template that can be used immediately or saved for later use. 

The NetBackup for DB2 Recovery Wizard saves a recovery template locally, in a 
user-specified location on the NetBackup client. Recovery templates are not stored on the 
server because recovery is always user directed, not scheduled. Under normal 
circumstances, a recovery template will be run immediately and then deleted. 

The recovery process sometimes requires passwords for DB2 database access and system 
user accounts. Templates store encrypted passwords that are decrypted at runtime. 

Because recovery can be a complex process, it may be necessary to perform manual steps 
as part of the operation. Please review your DB2 Backup and Recovery Guide for more 
information. 

Starting the NetBackup Backup, Archive, and Restore Interface 

The NetBackup for DB2 Recovery Wizard is launched from the Backup, Archive, and 
Restore interface. You can access the interface through the NetBackup Administration 
Console, or from the command line. 

❖	 To start the NetBackup Backup, Archive, and Restore interface from the command 
line, execute: 

install_path/netbackup/bin/jbpSA & 

The Restore Files tab 

Click the Restore Files tab, and expand the DB2 resource in the left pane to view a DB2 
instance hierarchy. Select a node in the left pane to view details in the right pane. 

DB2 Policy Type 

Note that if the DB2 node is not visible, it’s possible that your NetBackup for DB2 client 
does not have the appropriate policy type specified. Change the policy type with the 
following steps. 
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▼ To change the client policy type 

1. On the Actions menu, select Specify NetBackup Machines and Policy Type. 

2. On the Specify NetBackup Machines dialog, click the Source client/Policy type tab. 

3. In the Policy type drop down list, select DB2. 

4. Click OK. 

Using the Recovery Wizard 

When you are ready to perform a recovery, follow these steps to create and run a template 
with the Recovery Wizard. 
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▼ To use the Recovery Wizard 

1.	 In the Backup, Archive, and Restore interface, expand a DB2 instance and select the 
database object(s) you wish to restore. 

2. Click Restore. 

The NetBackup for DB2 Recovery Wizard displays several screens where you will 
enter information about the backup operation you want to perform: 

◆ Welcome 

◆ Database Login 

◆ Time Periods 

◆ Restore Options 

◆ Recovery Options 
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If you need an explanation of any of the fields on the wizard screens, or more details, 
click Help on the wizard screen. 

3. When you have completed the wizard, the Template Complete screen displays: 

You can choose to run the template immediately after the wizard finishes or save the 
template locally, or both. For explanations of your choices, click Help. 

When executing a template, all restore operations are performed before any/all 
roll-forward operations. 

Note	 When performing a DB2 restore, false alarms are reported in the NetBackup 
Activity Monitor. DB2 accesses the NetBackup image twice when performing a 
restore. The first access reads a partial image, which is reported as "The restore 
failed to recover the requested files" (status 5) in the Activity Monitor. The next 
access reads the entire image, which should result in a successful restore (status 0). 
The template execution status is the best indication of overall success, and not the 
activity monitor. 

Caution	 The DB2 warning SQL2539W indicates that the requested restore operation will 
replace the existing database (existing database files will be deleted). When 
executing a template to perform a restore, this warning is logged and the restore 
proceeds without interruption. 

The DB2 warning SQL2523W indicates that the backup image originates from a 
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different database of the same name. This is handled as an error, to prevent DB2 
from deleting log files. 

The DB2 error SQL1260N indicates that the restored partition is not configured 
for roll-forward recovery. If the template is configured to perform a 
roll-forward, this step is skipped. 

Template execution does not currently support the use of local time when performing a 
rollforward. The roll-forward time specified in the template is passed to DB2, and is 
interpreted as GMT by DB2. See the DB2 ROLLFORWARD command reference for details. 

Using bpdbsbdb2 

The bpdbsbdb2 command allows you to run a recovery template created by the 
NetBackup Recovery Wizard. 

At the command line, type: 

/install_path/netbackup/bin/bpdbsbdb2 -restore -r -t <template name> 

where -r runs a template and -t identifies the template 

For example: 

bpdbsbdb2 -restore -r -t /db2/restore_templates/full_restore.tpl 

Restore templates do not reside in a pre-determined location on the master server. They 
are considered to be temporary in nature and should reside on the client. If the full path is 
not specified as part of the restore template name, the file might not be found. 

For details about creating a script from a template using bpdbsbdb2, see “Creating Shell 
Scripts Using bpdbsbdb2” on page 76. 

Using DB2 to Perform a Restore 
The procedure for restoring a DB2 database depends on the database involved and the 
problems that you have on your system. See the DB2 UDB Administration Guide Data 
Recovery and High Availability Guide for a complete description of how to recover a DB2 
database. 

The following procedure shows how to restore our example database, SAMPLE, to the 
level of a recent database backup plus archive logs. 
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▼ To restore a database using DB2 

1.	 Perform a user-directed restore by executing the DB2 RESTORE DATABASE command 
from the command line on the client: 

For a Solaris or Linux client you would enter: 
db2 restore database sample load /install_path/netbackup/bin/nbdb2.so 

For an AIX or HP-UX client you would enter: 
db2 restore database sample load /install_path/netbackup/bin/nbdb2.sl 

Refer to the IBM DB2 Universal Database Command Reference manual for details on 
using the DB2 RESTORE DATABASE command. 

2. Browse and restore archive log. 

See “Using bplist to Browse” on page 91 in the previous section.  Also follow the 
instructions in “Using ARCFUNC During Restore of Archive Log Files” on page 68. 

3.	 Run the DB2 ROLLFORWARD DATABASE command. This brings the database back 
on-line. For example: 

db2 rollforward database sample to end of logs and stop


For more information on this command, refer to the IBM DB2 Universal Database 
Command Reference manual. 

Using xbp to Perform a Restore 
The following describes how to use xbp to restore your database. Refer to the xbp man 
page and the online help in the interface for detailed instructions on using xbp to restore 
database backups. 

▼ To use xbp to perform a restore 

1.	 Log in as the DB2 administrator or as root. 

If a different user account is used, change the su- command to the DB2 administrator. 

2.	 Execute xbp on the client to which you want to restore a database. 

install_path/netbackup/bin/xbp 

3.	 In the Directory to Search Box, type in the path name of the location of the DB2 scripts. 
For example: 
Chapter 4, Using NetBackup for DB2 101 



Performing a Restore 
install_path/netbackup/ext/db_ext/db2/scripts/


4. Choose File > Browse File System for Restore Scripts. The xbp dialog is displayed. 

5. Select the restore script from the Files pane. 

6.	 Choose Restore > Restore Database Using Selected Scripts. The xbp_confirm dialog 
is displayed. 

7.	 Click OK. 

A NetBackup process called bphdb starts the DB2 script on the client. 

8. View the status of the script execution. 

a.	 Choose Restore > Report Progress Of Restore.... 

The xbp_progress dialog is displayed. 

b. Select the log file for your restore. 

The Contents of Selected Log File pane displays only the status of the script 
execution. A status =0 message indicates that the script was successfully 
completed. Go to Step 9 for a detailed status report. For a status other than 0, refer 
to the Troubleshooting section of this manual. 

9. View the log file for the NetBackup operation. 

a.	 Change directories to the bphdb log directory. 

cd /usr/openv/netbackup/logs/bphdb 

b. Open the log file with the tail option. 

tail -f log.mmddyy


A Restore completed SUCCESSFULLY message indicates a successfully completed 
NetBackup operation. 
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5 

When a DB2 database is used by SAP software, NetBackup for DB2 can be used within 
that environment for backup and restore of SAP data. This chapter provides guidelines for 
using SAP, DB2, and NetBackup together. 

This chapter contains the following sections: 

◆ Installation of the DB2 User-Exit Program 

◆ Backup and Restore of DB2 Databases 

◆ Archive and Restore of DB2 Log Files 

◆ Backup of SAP Files 
103 



Installation of the DB2 User-Exit Program 
Installation of the DB2 User-Exit Program 
DB2 allows for the presence of a single user-exit program to manage archiving of database 
log files. Both SAP and NetBackup deliver user-exit programs for exclusive use by DB2. 
The user-exit program resides in the DB2 database directory as db2uext2. 

Note	 The use of the NetBackup user-exit program is required, because it provides for 
automatic archiving of log files to tape and on-demand recovery of log files by DB2. 

Take precautions when installing SAP to prevent overwriting the NetBackup user-exit 
program. Always preserve the NetBackup db2uext2 file before installing SAP, and restore 
afterwards. 

Backup and Restore of DB2 Databases 
Follow the standard NetBackup instructions in this document for backup and restore of 
the DB2 database(s) used by SAP. You may use either DB2 or NetBackup to initiate 
database backups and restores. 

Caution	 Do not use SAP CCMS, sapdba, brbackup, or brrestore commands to 
initiate backups or restores. They will not invoke NetBackup. 

Caution Also, SAP must not be running when attempting to restore the database. 

Archive and Restore of DB2 Log Files 
Follow the standard NetBackup instructions in this document for configuring the 
user-exit program. DB2 will automatically invoke the user-exit program to archive and 
recover the necessary log files. 

Caution	 DO NOT use SAP CCMS, sapdba, brarchive commands, or the SAP Logfile 
Management window in the DB2 Control Center for log file archival. They are 
dependent upon the SAP user-exit program for proper operation. 
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Backup of SAP Files 
Be certain to include any/all SAP files when planning for SAP recovery, not just the DB2 
database. For instance, any regular files used by SAP can be backed up using standard 
NetBackup file backup procedures.  For file backup instructions, consult the “Performing 
Backups” section in the NetBackup Backup, Archive, and Restore online help. 
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NetBackup for DB2 with Advanced Client 
6 

This chapter explains how to use NetBackup for DB2 with NetBackup Advanced Client to 
perform snapshot backups backups of your DB2 database. 

To use NetBackup for DB2 with Advanced Client, you must have both NetBackup 
Advanced Client and NetBackup for DB2 licensed and installed. 

The chapter provides information on the following topics: 

◆ Installation and Licensing Requirements 

◆ NetBackup for DB2 with Advanced Client Overview 

◆ How Does NetBackup for DB2 with Advanced Client Work? 

◆ Configuring a Snapshot Backup 

◆ Using NetBackup for DB2 with Advanced Client 
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Installation and Licensing Requirements 
To use NetBackup for DB2 with Advanced Client, you must have the following licensed 
and installed: 

◆ NetBackup for DB2 5.1 

◆ NetBackup Advanced Client 5.1 

For details on installing and configuring NetBackup Advanced Client, see the NetBackup 
Advanced Client System Administrator’s Guide. There are no additional VERITAS NetBackup 
installations required. Other hardware and software configurations may be necessary. See 
the configuration requirements for the specific advanced backup methods in the 
NetBackup Advanced Client System Administrator’s Guide for details. 
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NetBackup for DB2 with Advanced Client Overview 
NetBackup for DB2, when used in conjunction with NetBackup Advanced Client, can 
back up and restore DB2 objects by taking snapshots of the component files and then 
backing up the snapshot version to tape, or committing them to another form of persistent 
storage. This means capturing the data at a particular instant, without causing significant 
client downtime. The resulting capture or snapshot can be backed up without affecting 
the performance or availability of the database. 

Advanced Client Features 
The following NetBackup Advanced Client features are available for use with NetBackup 
for DB2: 

Snapshot Backup	 A snapshot is a disk image of the client's data made almost 
instantaneously. NetBackup backs up the data from the snapshot 
image, not directly from the client’s primary data. This allows client 
operations and user access to continue without interruption during the 
backup. 

Instant Recovery (formerly This feature makes backups available for “instant recovery” from disk. 
Instant recovery combines snapshot technology—the image is created 
without interrupting user access to data—with the ability to do rapid 
disk-based restores. Optionally, the image is retained on disk as well as 
backed up to storage.Instant recovery makes it possible to perform 
block-level restores. 

Persistent Frozen Image or 
PFI) 

Offhost Backup	 An offhost backup shifts the burden of backup processingonto a 
separate backup agent (alternate client, NetBackup media server, or 
third-party copy device), reducing the impact on the client's computing 
resources ordinarily caused by a local backup. The backup agent reads 
the data from the client disk and writes it to storage. 

Proxy Method 
Proxy method describes a special type of backup in which DB2 turns over control of the 
data transfer to the NetBackup for DB2 Agent. During DB2 backup and restore operations, 
a proxy method enables NetBackup for DB2 to manage the entire data movement between 
the disks containing DB2 datafiles and the storage devices managed by NetBackup. 

With a proxy method, NetBackup for DB2 obtains a list of files to back up through a DB2 
API. NetBackup for DB2 Agent makes all decisions regarding how the data is moved and 
when to move the data. 
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Stream-Based Operations vs. File-Based Operations 
Standard NetBackup for DB2 backups and restores are stream-based. NetBackup for DB2 
with Advanced Client operations are file-based. This section illustrates the difference 
between these operation types. 

Stream-Based Operations 

Stream-based operations are the standard NetBackup implementation of conventional 
backups and restores where NetBackup moves the data provided by the DB2 server 
process. NetBackup simply captures the data stream content provided by DB2 commands. 
If the user has specified multiple streams, then DB2 commands opens multiple streams 
that NetBackup catalogs as separate images. 

NetBackup for DB2 stream-based backup or restore 

DB2 database 
disk 

DB2 Server 

NetBackup 

Control commands Data 

disk 
DB2 database 

File-Based Operations 

In a file-based operation, NetBackup obtains a list of files requiring backup or restore 
through a DB2 API. NetBackup for DB2 with Advanced Client performs the actual data 
movement. 
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NetBackup for DB2 with Advanced Client file-based backup or restore 

DB2 Server 

NetBackup 

Data 

List of files 

Control commands 

Data 

DB2 database DB2 database 
diskdisk 
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How Does NetBackup for DB2 with Advanced Client Work? 
NetBackup users or schedules start database backups or restores by specifying a template 
or shell script in the backup selections list of the DB2 policy. The template or shell script 
specifies objects or commands that will be used to perform the backup or restore on the 
client. And Advanced Client backup of DB2 can also be initiated with the bpdb2proxy 
command. 

The agent checks that the policy it is using for the backup is configured with the 
appropriate Advanced Client attributes. The agent then initiates file-based backups of the 
DB2 files and uses the NetBackup Advanced Client interface to perform the actual data 
movement. 

The NetBackup for DB2 agent uses DB2 APIs to put the data files into quiesce/write 
suspend mode. NetBackup then creates a snapshot of the files. Once the snapshot has 
been created, NetBackup for DB2 uses the DB2 APIs to take the data files out of 
quiesce/write suspend mode. The data files being backed up are quiesce/write suspend 
mode only for the period of time it takes to create a snapshot of the data. 

Sequence of Operation: Backup 
For a backup operation, the NetBackup for DB2 agent performs the following steps: 

1. Maps the DB2 logical identifiers into physical file locations. 

2. Suspends write activity to the data files (quiesces the database). 

3. Uses the Advanced Client method to create a snapshot image of the mapped files. 

4. Enables DB2 write activity (unquiesces the database). 

5. Backs up the snapshot image of the data files. 

Sequence of Operation: Restore 
For a restore operation, the NetBackup for DB2 agent performs the following steps: 

1.	 Using the DB2 database and a point in time, locates the correct physical backup 
images. 

2. Disconnects all users from the database (brings the database offline). 

3. Restores the images to the original database. 
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4. Reruns the transactions from the log files. 

5. Enables user connections to the database (brings the database online). 

Database Objects Supported by Advanced Backup Methods 
Currently, DB2 allows proxy method backups of databases, tablespaces, and datafiles at 
the node level. As a result, NetBackup can use file-based Advanced Client backup 
methods to back up these objects. 

For archived redo logs, DB2 performs only conventional stream-based backups. This 
means that NetBackup for DB2 must use stream-based backups for archived redo logs 
even when using Advanced Client methods for the other database objects. 

File-based and stream-based backups require different configuration. When configuring 
NetBackup for DB2 with Advanced Client backups, be sure to configure policies that will 
allow both kinds of backups. See “Types of Backups” on page 122 and “Schedule 
Properties” on page 122 for details. 

Multistreaming 
The number of proxy copy backup streams to be started is controlled by the -s option on 
the bpdb2proxy command or the sessions parameter in the Backup Options screen of the 
Backup Wizard. NetBackup for DB2 splits the files into a number of groups as specified by 
either of these parameters, based on file size. NetBackup for DB2 attempts to create 
streams of equal size. 

Symbolic Links 
NetBackup for DB2 with Advanced Client fully supports backups and restores of datafiles 
that consist of symbolic links and regular files. Both the symbolic link and the actual file 
are backed up and restored. 
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Example: Using Multiple Channels for a DB2 Command with 
Proxy Method 

This NetBackup for DB2 sample command initiates a database backup on a per-node 
basis, which includes the archived logs. The agent splits the files into 3 streams and 
initiates a file-based backup for each stream. After the proxy backup is done, DB2 starts a 
non-proxy conventional backup of the archived logs. 

bpdb2proxy -backup -d sample -s 3 -n 0


Note This command must be performed for each node of the database. 
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Configuring a Snapshot Backup 

Snapshot Methods 
Advanced Client supports a number of methods for creating a snapshot image. You can 
select the method or let NetBackup select it based on your environment. For information 
on selecting a method, see the NetBackup Advanced Client System Administrator’s Guide. 

The snapshot method used is dependent on your hardware and software environment. 
For a complete explanation of these dependencies, see the NetBackup Advanced Client 
System Administrator’s Guide. 

Before configuring a policy for alternate client backups, make sure the following have 
been done: 

◆	 For the FlashSnap and VVR snapshot methods, VxVM 3.2 or later (for UNIX) or 
VxVM 3.1 or later (Windows) must be installed and volumes configured over the 
primary host’s disks. The VxVM FlashSnap or VVR license must also be installed. 

◆	 The user and group identification numbers (UIDs and GIDs) associated with the files 
to be backed up must be available to both hosts (the primary client and the alternate 
backup client). 

◆	 The primary and alternate clients must be running the same operating system, 
volume manager, and file system. For each of these I/O system components, the 
alternate client must be at the same level as the primary client, or higher level. For 
supported configurations, see the NetBackup Advanced Client System Administrator’s 
Guide. 

For a description of snapshot methods available for use with NetBackup for DB2, see the 
supported platforms matrix on the VERITAS support site. 

▼ To access the supported platforms information 

1. Go to the VERITAS support web page: http://www.support.veritas.com. 

2.	 From the Select Product Family list, choose NetBackup Products. The Select Product 
window refreshes showing a list of NetBackup products. 

3.	 Select one of the NetBackup products. The page refreshes and displays a search 
window with four tabs: 

◆ Documents 

◆ Downloads 

◆ Software Alerts 
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◆ Compatibility 

4. Select 5.1 in the Product Version drop-down field. 

5. Select a Product Platform. 

6.	 Click the Compatibility tab. The page will refresh showing documents that contain 
compatibility information. 

7.	 Click on the title of the document link for NetBackup Database Agent Compatibility 
List. A document appears that contains a downloadable file that enables you to view 
the supported database spreadsheet for this release. 

Configuration Requirements 
◆	 It is recommended that the archived logs should reside on a different volume(s) from 

the datafiles. If the logs are configured on the same volume(s) as the datafiles, they 
will also be temporarily frozen while the snapshot is created. As a result, the DB2 
process cannot access the logs when the database is active, so the database activity 
may freeze until the logs become accessible again. 

◆	 The hardware and software required for the appropriate snapshot method is installed 
and configured correctly. Refer to the NetBackup Advanced Client System Administrator’s 
Guide. See the VERITAS Technical Support Web site for details on the snapshot 
methods and platforms that are supported for your agent. 

◆	 NetBackup Advanced Client is installed and configured correctly and the license key 
for this option has been registered. Refer to the NetBackup Advanced Client System 
Administrator’s Guide for details. 

◆	 If you wish to perform offhost backups, perform any special configuration that is 
required. See the NetBackup Advanced Client System Administrator’s Guide for 
information on configuring for alternate client backups and notes on the NetBackup 
Media Server and Third Party Copy Device backup methods. 

Configuring a DB2 Policy with Advanced Client Backup 
Methods 

This section explains what is necessary to configure snapshot and instant recovery 
backups for a DB2 policy. For detailed instructions on configuring a DB2 policy refer to 
“Configuring a NetBackup Policy” on page 31. 

For information on how a snapshot method is automatically selected and details on the 
types of backup methods, refer to the NetBackup Advanced Client System Administrator’s 
Guide. 
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Snapshot backups do not back up all database objects. Your backup configuration must 
include policy types to perform file-based and stream-based backups in order to ensure 
that the entire database can be successfully restored. 

To configure DB2 snapshot or instant recovery backups a user needs to configure: 

◆ A DB2-type policy with the following attributes: 

◆ Snapshot methods for file systems where the datafiles reside 

◆ A backup method on the policy attributes dialog 

◆	 Automatic Full Backup schedule type to perform file-based snapshot and offhost 
backups of the datafiles 

◆	 A Standard type policy to perform a stream-based backup of archived logs. Note that 
DB2 does not support proxy backups of database archived logs. These files are backed 
up using standard user-exit operations. 

For details on policy attributes that differ for a NetBackup for DB2 with Advanced Client 
policy, see the following sections: 

◆ “Types of Backups” on page 122 

◆ “Schedule Properties” on page 122 

◆ “Templates and Scripts” on page 123 

Only one snapshot method can be configured per policy. If, for instance, you want to 
select one snapshot method for clients a, b, and c, and a different method for clients d, e, 
and f, then you would need to create two policies for each group of clients and select one 
method for each policy. 

The following types of snapshot backups can be configured: 

◆ snapshot backup 

◆ instant recovery, snapshot to disk and to tape


◆ instant recovery, snapshot to disk only


The following type of offhost backup method can be configured:


◆ alternate client


▼ To configure a snapshot policy (with optional offhost backup) 

1. Open the policy you wish to configure. 

2. Click on the Attributes tab. 

3. Select the DB2 policy type. 
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4. Select a Policy storage unit. 

Select the policy type. 

backups. 

method. 

Select appropriate storage 
unit or storage unit group. 

(Optional) Click Perform 
Offhost backup and specify a 

Click Perform snapshot 

Any_available is not supported for data movers (NetBackup Media Server or 
Third-Party Copy Device). 

Note	 If you are using third party copy as your offhost backup method, you must override 
the policy storage unit by specifying a locally attached storage unit for the 
Application Backup schedule. (This schedule is necessary to back up the archived 
redo logs and control file.) 

5. Click Perform snapshot backups. 

Note	 For Instant Recovery configuration steps, see “To configure a policy for instant 
recovery” on page 120. 

6.	 Choose to have NetBackup select the snapshot method or select the snapshot method 
manually. 
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◆	 By default, NetBackup will choose a snapshot method for you. If you have 
changed this setting and want NetBackup to choose the method automatically, 
click Advanced Snapshot Options and from the Snapshot method for this policy 
list, choose auto. 

◆	 If you wish to use a specific snapshot method, click Advanced Snapshot Options 
and from the Snapshot method for this policy list, choose the method you wish 
to use for this policy. 

See the NetBackup Advanced Client System Administrator’s Guide for details about 
selecting the snapshot method and automatic snapshot selection. 

7. To configure schedules, click on the Schedules tab. 

See “Types of Backups” on page 122 for information on how these schedules differ for 
an DB2 policy that supports Advanced Client methods. See “Schedule Properties” on 
page 122 for an explanation on how the properties differ for a schedule that supports 
Advanced Client methods. 

8.	 Optional: If you wish to reduce the processing load on the client, perform the 
following steps: 

a.	 The alternate client must be the client that shares the disk array. This option may 
require additional configuration. Refer to the NetBackup Advanced Client System 
Administrator’s Guide. 

b. Select Perform offhost backup. 

c. Click Use alternate client and enter the name of the alternate client. 

Note Use data mover is not a supported option for NetBackup for DB2. 

Note	 If you are using third party copy as your offhost backup method, you must override 
the policy storage unit by specifying a locally attached storage unit for the 
Application Backup schedule. (This schedule is necessary to back up the archived 
redo logs and control file.) 

9. Use the Clients tab to specify clients to be backed up by this policy. 

Refer to “Configuration” on page 27 for details on adding clients to a policy. 

Note that for NetBackup 5.1, it is no longer possible to configure a snapshot method 
on a per-policy, per client basis. Snapshot options are applied to all clients controlled 
by that policy. 

10. Use the Backup Selections tab to enter the template or script. 
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See “Templates and Scripts” on page 123 for information about using templates and 
scripts with a NetBackup for DB2 with Advanced Client policy. 

11. Configure other attributes and add any further desired schedules. Refer to 
“Configuration” on page 27 for more information. 

For instant recovery, configure an DB2 policy for snapshot backup as described in the 
above procedure. Additional configuration for instant recovery is described in the 
following procedure. 

▼ To configure a policy for instant recovery 

1. Open the policy you wish to configure. 

2. Click on the Attributes tab. 

3. Select the DB2 policy type. 

Select the policy type. 

backups. 

recovery. 

Select appropriate storage 
unit or storage unit group. 

Click Perform snapshot 

Click here to enable instant 

4. Select a Policy storage unit. 
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If you select Instant recovery backups to disk only on the Schedules tab (see step 8), 
the storage unit is not used for proxy file-based backups. You must configure a 
storage unit if you plan to use the same policy for stream-based backups of control 
files and archived redo logs. 

5. Click Perform snapshot backups. 

6.	 Choose to have NetBackup select the snapshot method or select the snapshot method 
manually. 

◆	 By default, NetBackup will choose a snapshot method for you. If you have 
changed this setting and want NetBackup to choose the method automatically, 
click Advanced Snapshot Options and from the Snapshot method for this policy 
list, choose auto. 

◆	 If you wish to use a specific snapshot method, click Advanced Snapshot Options 
and from the Snapshot method for this policy list, choose the method you wish 
to use for this policy. 

See the NetBackup Advanced Client System Administrator’s Guide for details about 
selecting the snapshot method and automatic snapshot selection. 

7. Select Retain snapshots for instant recovery. 

NetBackup retains the snapshot on disk, so that instant recovery can be performed 
from the snapshot. A normal backup to storage is also performed, if you do not select 
Instant recovery backups to disk only (see step 8). 

8. To configure schedules, click on the Schedules tab. 

a.	 Follow the instructions in the “Configuration” chapter earlier in this manual to 
configure an Application and Automatic schedule. 

See “Types of Backups” on page 122 for information on how these schedules 
differ for an DB2 policy that supports Advanced Client methods. See “Schedule 
Properties” on page 122 for an explanation on how the properties differ for a 
schedule that supports Advanced Client methods. 

b.	 Optional: If you wish to create a disk image only, open the Automatic Backup 
schedule and select Instant recovery backups to disk only. 

◆	 If Disk-only backup is selected, the image is not backed up to tape or other 
storage. NetBackup creates a disk snapshot only. Note that this disk snapshot 
is not considered a replacement for traditional backup. 

◆	 If Disk-only backup is not selected, NetBackup creates a disk snapshot and 
backs up the client’s data to the storage unit specified for the policy. 
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Types of Backups 

The Backup Types available on the Schedules tab of the policy play a different role for 
NetBackup for DB2 with Advanced Client backups. 

Description of Backup Types for DB2 

Application Backup	 The Application Backup schedule enables stream-based NetBackup 
operations. The Default-Application-Backup schedule is automatically 
configured as an Application Backup schedule. 

Note If you are using third party copy as your offhost backup method, you 
must override the policy storage unit by specifying a locally attached 
storage unit for the Application Backup schedule. 

Automatic Full For file-based proxy method backups, the Automatic backup schedule types 

Backup, serve two purposes:

Automatic 

◆ Automatic backup schedules automatically start the backups by running

Differential the NetBackup for DB2 scripts or templates.

Incremental Backup, 

◆ Automatic backup schedules perform the actual file-based snapshot
Automatic 

Cumulative backups of the database objects.


Incremental Backup Note Selecting any of the Automatic backup schedule types will result in a 
full backup. 

Schedule Properties 

Some of the schedule properties have a different meaning for Advanced Client database 
backups than for a regular database backup. These properties are explained below. 

Other schedule properties that are specific to DB2 backups are described in “Schedule 
Properties” on page 39. 

Description of Schedule Properties 

Property Description 

Retention Frequency based scheduling 

For proxy backups, NetBackup for DB2 uses the Automatic Full Backup, 
Automatic Differential Incremental Backup, or Automatic Cumulative 
Incremental Backup retention period to specify how long to keep proxy 
file-based backup images. 

Calendar based scheduling 

For proxy backups, NetBackup for DB2 with Advanced Client uses the 
Automatic Full Backup, Automatic Differential Incremental Backup, or 
Automatic Cumulative Incremental Backup retention period to specify how 
long to keep proxy file-based backup images. 
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Description of Schedule Properties (Continued) 

Property Description 

Multiple copies	 For proxy file-based backups, configure Multiple copies on the automatic 
backup schedule. 

Templates and Scripts 

You can use a template created by the NetBackup for DB2 Template Generation wizard to 
perform NetBackup for DB2 with Advanced Client backups. Once created, templates are 
stored on the NetBackup master server and are available for use by other NetBackup for 
DB2 clients. See “Creating Templates and Shell Scripts” on page 71 for details on creating 
a backup template. 

Whether you use a template or script, you must enable the advanced backup method for 
your clients by configuring the Advanced Client methods on the Attributes tab of the 
policy. At run time, the template checks the policy attributes to determine if an Advanced 
Client backup method is configured, and initiates the proxy file-based backup. 

If you choose to use a script, the script must be located on each client that will be backed 
up by the policy. You must include the DB2 bpdb2proxy command in the script to enable 
the advanced backup method. 
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Using NetBackup for DB2 with Advanced Client 
Once configuration is complete, performing NetBackup for DB2 with Advanced Client 
backups and restores is similar to regular NetBackup for DB2 operations. Differences are 
highlighted in the following sections. 

Performing Backups 
There are three ways to perform NetBackup for DB2 backups with Advanced Client: 

◆ server-directed, automatic and scheduled from the master server 

◆ user-directed, via template creation and execution on the client 

◆	 user-directed, from the command line as a DB2 user (with the bpdb2proxy 
command) 

Note	 All three of these methods require a DB2 policy with Advanced Client 
configuration. 

Server-Directed Backups 

The configuration procedures in this chapter describe the process for configuring policies 
for DB2 backups with Advanced Client. See “Configuring a DB2 Policy with Advanced 
Client Backup Methods” on page 116. These policies will result in Advanced Client 
backups for the DB2 database. 

User-Directed Backups Using Templates 

To perform a backup from the Backup, Archive, and Restore interface, you can run a 
template through DB2 Template Administration (by clicking Actions>Administer 
Templates>DB2). You can also create a new template using the DB2 Backup Wizard, and 
run the template from the Template Complete screen. 

The backup that results from the template will be an Advanced Client backup if the policy 
for the client is configured for Advanced Client methods. The policy can be specified in 
the DB2.conf file on the client. You can also specify the policy by adding the client to that 
policy on the master server. 

User-Directed Backups Using bpdb2proxy 

Use the bpdb2proxy command to perform an Advanced Client backup of your DB2 
database from the command line. You must be the DB2 user to use the bpdb2proxy 
command. For backups, specify the -backup option with bpdb2proxy. 
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Using NetBackup for DB2 with Advanced Client 
The following is the syntax for using bpdb2proxy to back up a DB2 database with an 
Advanced Client method: 

bpdb2proxy -backup -d<DBALIAS> -u<USER> -p<PASSWORD> 

For UNIX, -u and -p are optional. 

The following options are also available: 

-s specifies session 

-n specifies node (default is 0) 

Performing Restores 
Perform NetBackup for DB2 Advanced Client restores from the DB2 client. There are two 
methods available for restoring an Advanced Client backup of a DB2 database: 

◆ user-directed, via template creation and execution on the client 

◆	 user-directed, from the command line as a DB2 user (with the bpdb2proxy 
command) 

User-Directed Restores Using Templates 

To perform a restore from the Backup, Archive, and Restore interface, use the NetBackup 
for DB2 Restore Wizard to select the files you want to restore and the parameters for the 
restore. If the backup image in the catalog was created with Advanced Client methods, the 
restore will use Advanced Client methods. 

User-Directed Restores Using bpdb2proxy 

Use the bpdb2proxy command to perform an Advanced Client restore of your DB2 
database from the command line. You must be the DB2 user to use the bpdb2proxy 
command. For restores, specify the -restore option with bpdb2proxy. 

Note	 The backup image you restore with bpdb2proxy must be from an Advanced Client 
method backup, otherwise, the restore will fail. 

The following is the syntax for using bpdb2proxy to restore a DB2 database with an 
Advanced Client method: 

bpdb2proxy -restore -d<DBALIAS> -u<USER> -p<PASSWORD> 

For UNIX, -u and -p are optional. 
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Using NetBackup for DB2 with Advanced Client 
The following options are also available: 

-s specifies session


-n specifies node (default is 0)


-t specifies time of backup (mm/dd/yyyy[HH:MM:SS])
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Troubleshooting 
7


NetBackup, NetBackup for DB2 on UNIX, and the DB2 commands all provide reports on 
database operations. These reports are useful for finding errors associated with those 
applications. 

This chapter presents the following topics: 

◆ NetBackup Reports 

◆ Setting the Debug Level 

◆ Preventing Timeout Failures on Large Database Restores 

◆ Using NET_BUFFER_SZ to Speed Up a Slow Restore 

◆ False Restore Failures Reported in the Activity Monitor 

◆ Reason Code 
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NetBackup Reports 
NetBackup Reports 
The NetBackup server and client software allow you to set up detailed debug logs for 
troubleshooting problems that occur outside of either NetBackup for DB2 on UNIX or the 
DB2 commands. See the NetBackup Troubleshooting Guide for UNIX and Windows for a 
complete description of debug logs. Also see the 
install_path/netbackup/logs/README.debug file. 

Note	 These logs do not reveal errors that occur during the execution of the DB2 
commands, unless those errors also affect NetBackup for DB2. DB2 may (or may 
not) use the NetBackup for DB2 logs for errors in the application. Your best sources 
for DB2 error information are the logs provided by DB2. 

Note In general, each debug log corresponds to a NetBackup process and executable. 

▼ To enable the NetBackup for DB2 on UNIX logs 

1. Create the following directories on the client: 

install_path/netbackup/logs/bphdb

install_path/netbackup/logs/bpdb2


% cd install_path/netbackup/logs/

% mkdir bphdb

% mkdir bpdb2


For 64-bit, create: 

install_path/netbackup/logs/bpdb264 

% cd install_path/netbackup/logs

% mkdir bphdb

% mkdir bpdb264


2. Set the access permissions to 777 on these log directories. 

% chmod 777 bphdb 

% chmod 777 bpdb2


For 64-bit: 

% chmod 777 bpdb264


The following sections describe the logs created when you create the log directories. Use a 
text editor to view the contents of the logs. 
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NetBackup Reports 
bphdb Directory on the Client 

The install_path/netbackup/logs/bphdb directory contains the following types of logs. 
These logs are a good starting place to determine what type of error occurred. 

db2_stdout.mmddyy 

Unless redirected elsewhere, NetBackup places DB2 script output in this file. 

db2_stderr.mmddyy 

Unless redirected elsewhere, NetBackup places DB2 script errors in this file. 

log.mmddyy 

bphdb is the NetBackup Database Backup binary. This log contains 
debugging information for the bphdb process. NetBackup for DB2 on UNIX 
uses this client process for DB2 script execution. It is invoked when an 
automatic backup schedule is executed. 

bpdb2 Directory on the Client 

The install_path/netbackup/logs/bpdb2 directory contains the following 
execution log. 

log.mmddyy 

This log contains debugging information and execution status for the DB2 
NetBackup client processes linked to the library program provided with 
NetBackup for DB2 on UNIX. 

install_path/netbackup/logs/


NetBackup Server Reports 
NetBackup provides other reports that are useful in isolating problems. One such report is 
All Logs Entries on the server. See the NetBackup System Administrator’s Guide for Windows, 
Volume I or NetBackup System Administrator’s Guide for UNIX, Volume I for a description of 
this and other reports. 
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Setting the Debug Level 
You can control the amount of information written to the debug log in the 
install_path/netbackup/logs/ directories by changing the Database debug level. The 
higher the value, the more information is logged. In everyday normal operations, the 
default value of 0 is sufficient. However, VERITAS Technical Support may ask you to set 
the value higher when a problem is being analyzed. 5 is the highest possible setting. 

❖� To change the Debug Level, enter the following line in the bp.conf file. 

VERBOSE = 5 

Preventing Timeout Failures on Large Database Restores 
Large database restores sometimes fail when multiple restore sessions compete for 
resources. In this situation, a restore session can be delayed waiting for media or device 
access. If the delay is too long, the restore session times out. 

This problem can be resolved by increasing the Client Read Timeout property, which 
prevents session timeouts and allows the restores to complete successfully. 

Use the NetBackup Administration Console on the server to change the properties of each 
client that contains a database you may need to restore. The Client Read Timeout 
property is found on the Timeouts host properties dialog of the master and media servers. 
The default for the Client Read Timeout setting is 300 seconds (5 minutes). For database 
agent clients, increase the value significantly to prevent timeout errors, e.g. 30 minutes. 

Using NET_BUFFER_SZ to Speed Up a Slow Restore 
When the restore is slow you can speed it up by creating a file in the NetBackup install , 
/NET_BUFFER_SZ, on the NetBackup master server. In the file, add the size of the socket 
you want to set in number of bytes. For example, 32768 bytes = 32K. 

Note This only applies when the NetBackup master server is a UNIX machine. 

False Restore Failures Reported in the Activity Monitor 
In some restore scenarios reports a successful restore status while the NetBackup Activity 
Monitor reports failures. When performing a restore, DB2 may read a portion of a backup 
image and not the entire image. For example, an incremental image is read once to obtain 
information for performing an automatic restore, and read again to actually restore data. 
130 NetBackup for DB2 System Administrator’s Guide for UNIX 



Reason Code 
The first access is discontinued by DB2 before reading the entire image, which is reported 
as an error in the NetBackup Activity Monitor. Later, DB2 reads the entire image for 
restoring. An error reported in the Activity Monitor does not necessarily indicate a failed 
restore. Users should consult the status reported by DB2, and respond accordingly. 

Reason Code 
The following reason code can occur while accessing the NetBackup shared library during 
the processing of a DB2 database utility BACKUP or RESTORE. Refer to the log files for 
more detail information about an error message. 

1 

Message (from DB2): 

SQL2071N An error occurred while accessing the shared library 
“/incorrect/path/nbdb2.so”. Reason code: “1”. 

Cause: 

The vendor library cannot be found or accessed. 

Action: 

Verify that the correct path is specified, and that the vendor library exists and has 
the correct file access permissions. 

2 

Message (from DB2): 

SQL2071N An error occurred while accessing the shared library 
“/usr/openv/netbackup/bin/nbdb2.s0”. Reason code: “2”. 

Cause: 

Specified the 32-bit vendor library for a 64-bit instance, or vice versa. 

Action: 

Use the 32-bit vendor library on 32-bit instances, and the 64-bit library on 64-bit 
instances. 

300 

Message: 

ERR - No match for a database image file was found based on 

the following criteria.
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Reason Code 
Cause: 

The restore criteria of database name, instance, type, and backup time object can 
not be found in the NetBackup database. 

Action: 

Make sure the image you are trying to restore exist by using bplist to list it. 

Make sure the correct instance is being used. 

Make sure the correct values are set in db2.conf and bp.conf. 

If logging is turned on, check the current log file in 
install_path/netbackup/logs/bpdb2 directory for more information. 

305 

Message: 

ERR - found more than one object.


Cause: 

More than one DB2 backup images were found in the NetBackup database that 
matched the restore criteria of database name, instance, type and backup time. 

Action: 

This should not happen under normal operation. 

If logging is turned on, check the current log file in 
install_path/netbackup/logs/bpdb2 directory for more information. 

310 

Message: 

ERR - bp.config failed with <%d> status.


Cause: 

Unable to read configuration file install_path/NetBackup/bp.conf. 

Action: 

Make sure this file exists and is properly configured. 

If logging is turned on, check the current log file in 
install_path/netbackup/logs/bpdb2 directory for more information. 

330 

Message: 
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Reason Code 
ERR - Invalid options encountered for action %s.


Cause: 

Invalid option(s) encountered for the action. The %s is for a string that will be 
inserted according to the error condition. 

Action: 

Make sure the action parameters are used properly. 

335 

Message: 

ERR - in get DB2 UDB level.


Cause: 

NetBackup server and NetBackup DB2 shared library are not the same level. 

Action: 

Make sure NetBackup and DB2 shared library are the same level. Check the log 
file in install_path/netbackup/logs/bpdb2 directory for the version 
number of the shared library and the version number for NetBackup. If they are 
not the same, you will need to install the same level. 

380 

Message: 

ERR - db2.conf read status error <%d>.


Cause: 

db2.conf read status error. 

Action: 

Make sure the directory is accessible with read and write permissions. Also make 
sure the file exists and has read permission. 

385 

Message: 

ERR - Found multiple <DATABASE> entries before an <ENDOPER> 

entries was encountered.


Cause: 
Chapter 7, Troubleshooting 133 



Reason Code 
Found multiple DATABASE entries before an ENDOPER entries was encountered 
in the $DB2_Instance_Home/db2.conf file. 

Action: 

Remove the extra DATABASE entry. 

390 

Message: 

ERR - Found multiple <OBJECTTYPE> entries before an

<ENDOPER> entries was encountered.


Cause: 

Found multiple OBJECTTYPE entries before an ENDOPER entries was 
encountered in the $DB2_Instance_Home/db2.conf file. 

Action: 

Remove the extra OBJECTTYPE entry. 

395 

Message: 

ERR - Found multiple <POLICY> entries before an <ENDOPER> 

entries was encountered.


Cause: 

Found multiple POLICY entries before an ENDOPER entries was encountered in 
the $DB2_Instance_Home/db2.conf file. 

Action: 

Remove the extra POLICY entry. 

400 

Message: 

ERR - Found multiple <SCHEDULE> entries before an <ENDOPER> 

entries was encountered.


Cause: 

Found multiple SCHEDULE entries before an ENDOPER entries was 
encountered in the $DB2_Instance_Home/db2.conf file. 

Action: 
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Remove the extra SCHEDULE entry. 

405 

Message: 

ERR - Found multiple <ARCFUNC>entries before an <ENDOPER> 

entries was encountered.


Cause: 

Found multiple ARCFUNC entries before an ENDOPER entries was encountered 
in the $DB2_Instance_Home/db2.conf file. 

Action: 

Remove the extra ARCFUNC entry. 

410 

Message: 

ERR - Found multiple <ARCDIR> entries before an <ENDOPER> 

entries was encountered.


Cause: 

Found multiple ARCDIR entries before an ENDOPER entries was encountered in 
the $DB2_Instance_Home/db2.conf file. 

Action: 

Remove the extra ARCDIR entry. 

415 

Message: 

ERR - Found multiple <RETDIR> entries before an <ENDOPER> 

entries was encountered.


Cause: 

Found multiple RETDIR entries before an ENDOPER entries was encountered in 
the $DB2_Instance_Home/db2.conf file. 

Action: 

Remove the extra RETDIR entry. 
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420 

Message: 

ERR - need to specify a valid POLICY or SCHEDULE in db2.conf 

for <DATABASE %s> and <OBJECTTYPE %s>.


Cause: 

Policy name or schedule name is not specified in the POLICY SHEDULE entry in 
the $DB2_Instance_Home/db2.conf file. 

Action: 

Add an appropriate policy name or schedule name to the POLICY or SCHEDULE 
entry. 

425 

Message: 

ERR - need to specify a valid ARCDIR in db2.conf: Errno = %d 

: %s.


Cause: 

Invalid ARCDIR is specified in db2.conf. 

Action: 

Add an appropriate directory name to the ARCDIR entry. 

430 

Message: 

ERR - ARCDIR field needs to be specified in the db2.conf 

file.


Cause: 

No ARCDIR entry found in the $DB2_Instance_Home/db2.conf file. 

Action: 

Add ARCDIR field to the $DB2_Instance_Home/db2.conf file with an 
appropriate directory name as a parameter. 

435 

Message: 
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Reason Code 
ERR - RETDIR field needs to contain a valid file when 

OBJECTTYPE is equal to ARCHIVE: %s.


Cause: 

RETDIR field does not contain a valid file. 

Action: 

RETDIR field needs to contain a valid file when OBJECTTYPE is equal to 
ARCHIVE in the $DB2_Instance_Home/db2.conf file. 

440 

Message: 

ERR - COPY or SAVE needs to be specified for ARCFUNC when 

OBJECTTYPE is equal to ARCHIVE.


Cause: 

Found OBJECTTYPE equal to ARCHIVE but no ARCFUNC is found in the 
db2.conf file. 

Action: 

Need to specify a copy or save parameter for ARCFUNC when OBJECTYPE is 
equal to ARCHIVE. 

445 

Message: 

ERR - Invalid <OBJECTTYPE> entries: <%s>.


Cause: 

Invalid OBJECTTYPE entry in the $DB2_Instance_Home/db2.conf file. 

Action: 

Add the appropriate object type to the $DB2_Instance_Home/db2.conf file. 

450 

Message: 

ERR - OBJECTTYPE entry needs to be specified.


Cause: 

OBJECTTYPE entry is not specified in the $DB2_Instance_Home/db2.conf file. 

Action: 
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Add the appropriate object type to the $DB2_Instance_Home/db2.conf file. 

455 

Message: 

ERR - POLICY entry needs to be specified.


Cause: 

POLICY entry is not specified in the $DB2_Instance_Home/db2.conf file. 

Action: 

Add the appropriate policy name to the POLICY entry in the 
$DB2_Instance_Home/db2.conf file. 

502 

Message: 

NetBackup DB2 Handle Invalid 

Cause: 

Internal communication between DB2 and NetBackup has failed. 

505 

Message: 

The input parameters supplied by DB2 are not valid. 

Cause: 

This may result from using an unsupported version of DB2 

507 

Message: 

NetBackup Initialize Failed 

Cause: 

NetBackup encountered errors in preparing for the requested operation.  This 
may result from improper configuration. 

510 

Message: 
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Reason Code 
NetBackup Read Config Failed 

Cause: 

NetBackup encountered errors in reading configuration settings. 

Action: 

Check that the NetBackup client & server settings have been configured, and that 
the db2.conf file exists and has been configured. 

511 

Message: 

NetBackup Write Config Failed 

Cause: 

NetBackup encountered errors in preparing for the requested operation.  This 
may result from improper configuration. 

513 

Message: 

NetBackup Begin Action Failed 

Cause: 

NetBackup encountered errors when attempting to start the requested operation. 
This may indicate a problem in obtaining necessary resources. 

514 

Message: 

NetBackup Create Image Failed 

Cause: 

NetBackup encountered errors when attempting to create a backup image. 

515 

Message: 

NetBackup Get Image Failed 

Cause: 

NetBackup encountered errors when attempting to access a backup image. 
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516 

Message: 

NetBackup Find Image Failed 

Cause: 

NetBackup encountered errors when attempting to locate a backup image. 

518 

Message: 

NetBackup Write Failed 

Cause: 

NetBackup encountered errors when writing a backup image. 

520 

Message: 

NetBackup Read Failed 

Cause: 

NetBackup encountered errors when reading a backup image 

523 

Message: 

NetBackup Commit Data Failed 

Cause: 

NetBackup encountered errors when attempting to close the backup image. 

524 

Message: 

NetBackup Commit Action Failed 

Cause: 

NetBackup encountered errors when attempting to complete the requested 
operation. 
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526 

Message: 

NetBackup Abort Action Failed 

Cause: 

NetBackup encountered errors when attempting to abort the previously 
requested operation. 

528 

Message: 

NetBackup Delete Image Failed 

Cause: 

NetBackup encountered errors when attempting to expire an incomplete backup 
image.  This typically indicates the previous operation has failed, and DB2 is 
attempting to delete any incomplete image. 
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Configuration for a DB2 EEE (DPF) 

Environment 
A

This appendix contains instructions for configuring NetBackup for DB2 in an 
Extended-Enterprise Edition (EEE) or Database Partitioning Feature (DPF) environment. 
In this appendix, all instructions that refer to an EEE environment are also applicable for a 
DPF environment. 

The following is the configuration procedure. 

1. Configure media. 

The instructions for configuring the Media Manager for DB2 EEE are the same as 
those for DB2. Refer to “Configuring Media Using Media and Device Management” 
on page 29. 

2. Set the Maximum Jobs per Client property. 

The instructions for setting the Maximum Jobs per Client property for DB2 EEE are 
the same as those for DB2. Refer to “Setting the Maximum Jobs Per Client Property” 
on page 29 . 

3. Add NetBackup policies for the DB2 EEE environment. 

The instructions for adding policies to NetBackup are different for DB2 EEE. Refer to 
“Adding NetBackup Policies for DB2 EEE Environment” on page 144. 

4. Create DB2 Scripts for the DB2 EEE environment. 

The instructions for creating scripts for DB2 EEE are the same as those for DB2. Refer 
to “Creating Templates and Shell Scripts” on page 71. 

Also refer to “Creating DB2 Templates or Scripts for a DB2 EEE Environment” on 
page 148 to view a DB2 EEE script. 

5. Create a $DB2_Instance_Home/db2.conf file. 

The instructions for configuring the db2.conf files for DB2 EEE are the same as those 
for DB2. Refer to “Configuring the Run-Time Environment” on page 65. 

6. Test NetBackup for DB2 EEE configuration settings. 
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Adding NetBackup Policies for DB2 EEE Environment 
The instructions for testing DB2 EEE configuration settings are the same as those for 
DB2. Refer to “Testing NetBackup for DB2 Configuration Settings” on page 80. 

Adding NetBackup Policies for DB2 EEE Environment 
A DB2 EEE environment requires two separate DB2 policies: one for an Application 
Backup schedule type of backup and another for an Automatic Full Backup, Automatic 
Differential Incremental Backup, or Automatic Cumulative Incremental Backup schedule 
type of backup. 

To back up archive logs it will be necessary to add a separate Standard-type policy. 

The following policies must be configured for a DB2 EEE environment. 

◆	 A DB2 type policy that has an Automatic Full Backup, Automatic Differential 
Incremental Backup, or Automatic Cumulative Incremental Backup backup type 
schedule. 

This policy should contain only one Automatic Full Backup, Automatic Differential 
Incremental Backup, or Automatic Cumulative Incremental Backup backup schedule 
type. It includes only the clients that: 

◆ contain the system catalog 

◆ run a DB2 script. 

The script uses the IBM db2_all command to archive the catalog nodes before any 
other node is backed up. For configuration instructions, see the next topic “To Create a 
DB2 policy with Automatic Backup schedule type” on page 144. 

◆ A DB2 type policy with an Application Backup schedule type. 

This policy should contain only one Application backup schedule type . This policy 
includes all clients to be backed up in the client list, including the catalog node. For 
configuration instructions, see the “To create a DB2 policy with Application Backup 
schedule type” on page 146.” 

◆ Standard type policy with a User Backup type schedule. 

For configuration instruction, see “To Create a Standard Policy” on page 146. 

▼ To Create a DB2 policy with Automatic Backup schedule type 

Note	 Do not specify this policy or schedule name in the $DB2_Instance_Home/db2.conf 
file. 
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1. Add a new policy, as specified in “Configuring a NetBackup Policy” on page 31. 

2. Specify the general attributes for the policy: 

a. Select DB2 for the policy type. 

b. Specify other attributes as desired. 

3. Delete the schedule called Default-Application-Backup. 

4.	 Configure a schedule for an Automatic Full Backup, Automatic Differential 
Incremental Backup, or Automatic Cumulative Incremental Backup type of backup. 

When the NetBackup scheduler invokes an Automatic Full Backup, Automatic 
Differential Incremental Backup, or Automatic Cumulative Incremental Backup type 
of backup, NetBackup for DB2 on UNIX will execute the DB2 scripts listed in the 
Backup Selections list, on each client listed in the Client list. 

Since all the DB2 scripts execute during automatic backups, you may need a separate 
DB2 policy for each type of backup you want to execute automatically on the same 
database. For example, to perform both full and tablespace backups of the same 
database, two different DB2 scripts are required. If you put both DB2 scripts in the 
same DB2 policy, NetBackup for DB2 on UNIX executes both of them during each 
Automatic Backup session for that DB2 policy. This means that you will be 
performing both full and tablespace backups during the same backup type, which is 
normally undesirable. 

5. Configure the Backup Selections list. 

Note	 Specify a Backup Selections list if unattended scheduled backups are going to be 
performed. 

List the DB2 scripts that you want to execute on the client. Always specify the full 
path name for a DB2 script in the Backup Selections list. For example: 

/myscripts/db2_backup.sh


Note	 The scripts provided are not intended for production. Modify these scripts to suit 
your needs. 

See “Creating DB2 Templates or Scripts for a DB2 EEE Environment” on page 148 for 
information on creating a DB2 script. 

Caution NetBackup does not interpret a DB2 script. Be sure to use the correct DB2 script 
name in the file list to prevent an error or possibly a wrong operation. 
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6.	 Specify all DB2 clients that will run the DB2 script. These must be the clients that 
contain the system catalog. 

7. Click OK. 

The Add New Policy dialog box closes. The policy you just configured appear in the 
policy list. 

▼ To create a DB2 policy with Application Backup schedule type 

Note	 The name of the policy must be specified in the $DB2_Instance_Home/db2.conf 
file on the client. 

1. Add a new policy, as specified in “Configuring a NetBackup Policy” on page 31. 

2. Specify the general attributes for the policy: 

a. Select DB2 for the policy type. 

b. Specify other attributes as desired. 

3.	 Double-click the schedule called Default-Application-Backup. Configure the schedule 
properties for an Application Backup schedule type. 

4.	 Specify the clients that you want to back up. The client must: 

◆ Have DB2 UDB installed 

◆ Have NetBackup for DB2 on UNIX installed 

Note No Backup Selections list is required for a User Backup policy. 

5. Click OK. 

The Add New Policy dialog box closes. The policy you just configured appear in the 
policy list. 

▼	 To Create a Standard Policy 

A Standard type policy must be added when: 

◆ userexit for logging is turned on in DB2 UDB. 

◆ Client is a UNIX machine. 

Note	 The name of the policy must be specified in the $DB2_Instance_Home/db2.conf 
file on the client. 
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1. Add a new policy, as specified in “Configuring a NetBackup Policy” on page 31. 

2. Specify the general attributes for the policy: 

a. Select Standard for the policy type. 

b. Specify other attributes as desired. 

3. Add a schedule: 

a. Type the name of your schedule. 

b. In the Type of Backup box, select User Backup. 

This is a user backup that is started by the NetBackup for DB2 on UNIX user-exit 
program on the client. This schedule specifies the criteria for DB2 archive logs file 
backups. A User Backup schedule enables user controlled NetBackup operations 
performed on the client. 

c.	 In the Retention box, set the time period needed to retain two full backups of 
your database. 

For example, if your database is backed up once every Sunday morning, select a 
retention period of at least two weeks. 

d.	 In the Start Window section of the Schedules dialog, set the time of day when 
you want backups to occur. 

This schedule must encompass all of the time periods during which DB2 UDB can 
call the user-exit program. 

Note No Backup Selections list is required for a User Backup policy. 

4.	 Specify the clients that you will be backing up. The client must have: 

◆ DB2 UDB installed 

◆ NetBackup for DB2 on UNIX installed 

5. Click OK. 

The Add New Policy dialog box closes. The policy you just configured appears in the 
policy list. 
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Creating DB2 Templates or Scripts for a DB2 EEE 
Environment 

Templates 
Templates are currently limited to operating on a single NetBackup client. If your 
EEE/DPF environment spans multiple machines, you must create at least one template 
for each machine. For example, assume your database spans two hosts, and host H1 
contains partition P1, and host H2 contains partitions P2 and P3. You will need at least 2 
templates: 

◆ One template for partition P1 on host H1 

◆ One template for partitions P2 and P3 on host H2. 

Caution	 Proper backup and restore of the catalog partition is the user's responsibility. 
Generally, it is recommended that the catalog partition is the first node backed 
up, and also the first partition restored. Refer to the DB2 Data Recovery Guide for 
details. 

For information on creating Backup templates, see “Using the NetBackup for DB2 Backup 
Wizard” on page 74. For information on creating recovery templates, see “Using the 
NetBackup for DB2 Recovery Wizard” on page 96. 

Roll-forward recovery to a point-in-time is not currently supported. DB2 requires that PIT 
recovery is executed via the same operation for all partitions and tablespaces on all 
machines. Templates do not currently support spanning machines. 

Scripts 

▼ To create scripts for a DB2 EEE Environment 

1.	 Copy the example scripts to a different directory on your client. DB2 scripts must be 
in a safe location. For clustered environments, this location should be available after a 
failover. 

2. Modify the script 

a. Use a text editor to open the script. 

b. Follow the instructions in the script. 
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Note	 Test the scripts you just created by backing up the policy as explained in “Testing 
NetBackup for DB2 Configuration Settings” on page 80. 
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